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Preface 

 

The Regional Project “Scientific Cooperation to Support Responsible Fisheries in the 
Adriatic Sea” (AdriaMed) is executed by the Food and Agriculture Organization of the 
United Nations (FAO) and funded by the Italian Ministry of Agriculture Food and Forestry 
Policies (MiPAAF) and since 2007 from the Directorate General for Fisheries and Maritime 
Affairs of the European Commission. 

 
AdriaMed was conceived to contribute to the promotion of cooperative fishery management 
between the participating countries (Republics of Albania, Croatia, Italy, Montenegro and 
Slovenia), in line with the Code of Conduct for Responsible Fisheries adopted by the UN–FAO. 

 
Particular attention is given to encouraging and sustaining a smooth process of international 
collaboration between the Adriatic Sea coastal countries in fishery management, planning and 
implementation. Consideration is also given to strengthening technical coordination between 
the national fishery research institutes and administrations, the fishery organizations and the 
other relevant stakeholders of the Adriatic countries. 
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Preparation of this document 

 
This document is the final version of the material used for the preparation of the training 
course on the use of Echoview organized by the AdriaMed Project in cooperation with the 
MedSudMed Project and carried out from 12th to 14th May 2008 in Ancona, Italy. 
 
Hydroacoustic data processing for standard stock assessment using Echoview. Echoview 
Technical Manual draws on: 

• Echoview training and tutorial materials 
• Cited texts and papers 
• The NOAA/NMFS protocols 
• The Standard Operating Procedures  for Acoustics in the Great Lakes 

 
It is hoped that the technical manual will aid you in using Echoview to process your 
hydroacoustic data for the purpose of standard stock assessment. 
 
Due to its technical nature the manual’s topics only provide a general introduction/guide to 
the issues and types of data processing you may need to consider for your data. For a more 
solid scientific and theoretical foundation for your work, we advise that you seek further up 
to date information in the hydroacoustic literature. 
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ABSTRACT 

This technical manual is written as a guide on how to use Echoview to process hydroacoustic 
survey data from marine or riverine locations. The theoretical ideas and guides for this 
manual’s processing methodologies are drawn from: i) Simmonds and MacLennan1 (2005); 
ii) The Standard Operating Procedures (SOP) for Acoustics in the Great Lakes2 (2008). In 
particular the numbered procedures from Chapter 3. Summary of Standard Operating 
Procedures are cited; iii) The NMFS/NOAA document3 (2004) – NOAA Protocols for 
Fisheries Acoustics Surveys and Related Sampling – the Great Lakes SOP draws from this 
document. Echoview offers many features and settings to facilitate the processing of data for 
analysis on screen and as exported analyses. Exported analyses can be evaluated in third 
party database and spreadsheet applications. Many procedures are demonstrated using Simrad 
EK60 (38kHz, 120kHz) and EK500 data. 
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Introduction 
Processing hydroacoustic survey data in Echoview 
This technical manual is written as a guide on how to use Echoview to process hydroacoustic 
survey data from marine or riverine locations. The theoretical ideas and guides for this 
manual’s processing methodologies are drawn from: 

 Simmonds and MacLennan1 (2005) 

 The Standard Operating Procedures (SOP) for Acoustics in the Great Lakes2 (2008). 
In particular we cite numbered procedures from Chapter 3.Summary of Standard 
Operating Procedures. 

 The NMFS/NOAA document3 (2004) – NOAA Protocols for Fisheries Acoustics 
Surveys and Related Sampling – the Great Lakes SOP draws from this document. 

Echoview offers many features and settings to facilitate the processing of data for analysis on 
screen and as exported analyses. Exported analyses can be evaluated in third party database 
and spreadsheet applications. 

Many procedures are demonstrated using Simrad EK60 (38kHz, 120kHz) and EK500 data. 

Note: This manual’s screenshots and EV files were created with Echoview 4.50. Other 
versions of Echoview may offer a slightly different set of tools and features and display data 
differently. See also Appendix B: Unable to open Echoview’s Technical Manual data files in 
Echoview. 

Training with the manual 
What’s covered? 

This manual provides an introduction to hydroacoustic data processing in Echoview. 

Data files from a survey are processed so that you can export information that can be used in 
estimating biomass and where applicable fish flux in fish counts per hour. 

This manual shows you how to do the following with hydroacoustic data: 

 View and scrutinize data – using EK60, EK500 and HAC data as examples. 

 Enter calibration settings for the transducer and data 

 Remove noise, remove unwanted signal 

 Create a surface line 

 Create an acoustic bottom line 

 Manually partition data by using region types and region classes 

 Detect schools – automated detection of regions 

 Specify cell size 

 Apply a Sv or a TS threshold to Sv data 



 

 

xx

 Integrate Sv 

 Detect single targets  

 Study TS 

 Create fish tracks  

 Use a dB differencing technique with EK60 38 kHz and 120 kHz data to classify 
species 

 Apply virtual variables to implement complex data manipulation. 

 Export analyses for species classified biomass calculations 

 Export analyses for fish counting 

 Calculate fish flux for riverine data 

 Apply Echoview 3D visualization to single beam data 

 Make an EV file template to automate the processing of hydroacoustic data 

 Live view EK60 data in Echoview 

What is not covered? 

This is not intended as a comprehensive user manual.  

Further information on Echoview tools and topics can be found in the latest version of the 
Help file that comes with Echoview. This file can also be viewed online or downloaded with 
Echoview from the Echoview website: http://www.echoview.com. 

Prerequisites 

This manual assumes you have the following skills and knowledge: 

 Familiarity with the basic operation of Echoview. We strongly recommend that you 
complete the Echoview tutorials before beginning this manual.  

 Familiarity with one of the following operating systems: Microsoft Windows™ 
2000/XP/Server2003™. 

 A basic understanding of echosounding techniques and hydroacoustic surveying. For 
more information, see texts such as Fisheries Acoustics 2nd Ed. (MacLennon and 
Simmonds, 2005, Blackwell Science, Oxford). 

 An understanding of the operation of echosounding equipment. For more 
information, refer to the operator's manual for the echosounder(s) you will be using. 

 Echoview is installed. 

Typical styles in the manual 

The manual uses cross references and URLs, they are indicated by blue text. 
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What is covered? 

Topic completed 

What is covered? or Topic completed. 

The What’s covered? text outlines the aims of the topic. 

The Topic completed text outlines the skills gained from the topic. 

 

 

Theory 

 
The Theory icon is associated with directly relevant text dealing with hydroacoustic 
theory or hydroacoustic data processing in Echoview. The text is often used to set up the 
context for the next data processing step. 

Steps 

The Steps icon is associated with “cookbook style” instructions for a data processing step. 

Tips and tricks 
 The Tips and tricks section contains further information which may be handy to know.  Such 

information may aid in the development of a deeper understanding of the subject but is not 
essential for the processing step. Text can cover: 

 References to the Echoview help file. 

 Further discussion of the hydroacoustic theory. 

 Other references or discussion.  

 

Supplied data files 

The data files used with this manual’s example EV files are provided with the permission of 
those people or groups listed in the “Acknowledgments” section. 

Installation of this manual’s data files and templates 
The Echoview technical manual is provided as a PDF file with a self installing zip file for the 
data files and EV files: 

 Echoview_Technical_Manual.pdf 

 Echoview_manual.exe (Double-click the .exe file to install to: 
C:\Myriax\Echoview\Echoview4\Echoview manual) 
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Solution files 
Solution EV files are provided in the respective data folders and are named * (Solution).EV. 
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1. View and inspect data 
What is covered? 

To view and initially inspect hydroacoustic data in Echoview you need to: 

 Add data to a new Echoview EV file . 

- OR- 

 Add data to a new EV file based on a template. 

This topic inspects an EK60 single frequency data file. The principles apply to any data file 
format that Echoview supports. 

 

Echoview and data files 

 
An EV file is made up of: 

 a Fileset or Filesets containing pointers to survey data files 

 the results of any edits or Echoview display and analysis settings associated with 
the survey data 

A Fileset is used: 

  to manage a group of data files 

  to derive raw variables. 
Data files are usually primary information archived from a survey and consist of data 
logged from echosounders or sonars and other equipment. 
Echoview derives raw variables from the data files in a fileset. 

When a data file is added to a Fileset in an EV file the original data will never be copied 
or modified in any way.  

You can analyze data in a new EV file based on a template or in a new EV file. 

A new EV file based on a template contains stored display and analysis settings that can 
be fine tuned when you add appropriate data. 

A new EV file requires you to determine and enter display and analysis settings for your 
data.  

Create an EV file based on a template 
For more information about creating and using templates refer to About templates. 
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1. Start Echoview. 

Configure a path for a Templates folder 

See also Creating a template. 

2. On the File menu select Configuration. 

3. Click the File locations page. 
In the Files types section click Templates. 
Click Edit. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\9 Templates 
Click OK 
Click OK 

Create an EV file 

4. On the File menu click New. 

5. In the New EV file (Template) dialog box, click Echoview manual template.EV 
Click OK. 
This template has stored settings for: 
Best bottom line pick virtual line 
Variable Properties for the Position variable – settings on Data page 
EV file Properties – Echogram page (display Notes for marker regions) 
A virtual variable copy of the Sv echogram configured for along-track display. 

6. On the Filesets – File 1 window click Add. 

7. Use the Add Data Files dialog box to find the data file: 
C:\Myriax\Echoview\Echoview4\Echoview manual\1 View and inspect\L0014-
D20021004-T140000-EK60.raw, 
Click Open. 

8. On the File 1 page of the Filesets dialog box, the listed Raw Variables are: 

Raw Variable Meaning 

Sv raw pings T1  Sv pings from transceiver 1; 

 
Sv Echogram. 

TS raw pings T1  TS pings from transceiver 1; 

 
TS Echogram 
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angular position raw 
pings T1  

Angular positions from transceiver 1, 

 
Angular position echogram 

position GPS fixes  GPS fixes  

 
Cruise track. 

9. To view the Raw Variable: double-click it, or select it and click Echogram. 

Create a new EV file 

1. Start Echoview. 

2. On the File menu click New. 

3. In the New EV file (Template) dialog box, click No template. 
A new EV file is created with default settings. 

4.  On the Filesets – File 1 window click Add. 

5. Use the Add Data Files dialog box to find the data file: 
C:\Myriax\Echoview\Echoview4\Echoview manual\1 View and inspect\L0014-
D20021004-T140000-EK60.raw, 
Click Open. 

6. In the Filesets – File 1 dialog box, the derived Raw Variables are: 
Sv raw pings T1  
TS raw pings T1 
angular position raw pings T1  
position GPS fixes  
(View the descriptions of the Raw Variables in the Create a new EV file based on a 
template section). 

7. To view a Raw Variable, double-click the name of the Raw Variable. 
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About echograms 

 
An echogram is a visual representation of acoustic data. Single beam echograms display 
pings in the horizontal direction and samples within pings in the vertical direction. 

 
Figure 1. Small rectangle is a part of an Sv echogram showing fish near the sea floor. The large square shows a 

zoom of the area and clearly shows pings and samples within pings. 

 

Features on an echogram can be a result of:  

 Echoes from biological sources 
e.g. Individual fish, fish aggregations, plankton, other sea creatures 

 Echoes from non-biological or geological sources  
e.g. sea floor, sea mounts, structures 

 Echoes from noise or reverberation 
e.g. ship noise, cavitation, transducer interference, transducer ringing, bergy bits, 
electronic noise, bubbles in the sea, unwanted biological echoes. 
See also Reverberation and noise. 

In many cases, information from sources like hydrographic data, local geographic 
knowledge, trawl or direct sampling data, biology and ecosystem knowledge and 
echosounder/sonar experience can help you to identify features on an echogram. 

Cells 

 
Cells provide a systematic way to partition, refer to and navigate echogram data. Cells are 
useful at the View and inspect stage and the Scrutinization and Analysis stages. 

Cells are referenced by (Layer number, Interval number), where layer and interval are 
specified on the Grid page of the Variable Properties dialog box: 

 The time/distance grid settings specify intervals across the echogram. 

 The depth/range grid settings specify layers down the echogram. 

Cells are useful for: 

 onscreen analyses 

 exported analyses 
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 the calculation of density 

 the calculation of biomass 

View echograms and cruise track 

8. Use either the new EV file based on a template or the new EV file from step 7. 

Onscreen information 

9. Click Details . 
The Details dialog box (opened by the Details tool), the Information toolbar and the 
Echoview status bar all respond to the position of the mouse pointer and display 
useful information. 
 

 
Figure 2. Information toolbar. Note the Goto ping number feature ( ping 614) on the left hand side. 

 

Figure 3. Echoview status bar 

10. Click the Color legend tool . 
The information in the Color legend responds to the active echogram or active 
window. 

11. View the Sv echogram. 

Selection, zoom 

12. To view an area of interest, 

Click the Rectangular selection tool  on the Echogram tools toolbar. 
Make a selection on the echogram with the mouse pointer. 

Use the Zoom tools  or Zoom shortcuts (S, U). 
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Figure 4. Features of the Sv echogram in the Echoview manual EV file template. 

13. Features on Figure 4: 
Highlighted long rectangle – plankton. 
Highlighted square – individual fish. 
Red arrow – points to bright green picked bottom line. Signal directly beneath line is 
the strong signal for the sea floor. 
Strong signals below the picked bottom line are a result of multiple reflections from 
the sea floor. 
Green picked line for bottom (Template file)  

Settings 

14. To view or use the Variable Properties dialog box for the Sv variable: 
Move the mouse over the active variable 
Select Variable Properties on the Shortcut (right-click) menu. 
View the pages and settings. 

15. On the Display page, under the Echogram colors section observe the settings: 
Color display minimum: -70 
Color display range: 36 
These settings only affect the display of data. Thresholds specifically for analysis are 
set on the Data page. 
To close, Click OK. 

16. Click on the Sv echogram.  
To see data with weaker echoes press F11 – the Color display minimum changes to -
71, -72, -73 … 
To see data with strong echoes press F12– the Color display minimum changes to -
69, -68, -67 … 

17. View the TS echogram and repeat steps 10-14. 

18. View the Angular position echogram and repeat steps 10-13. 

Observe the Color legend  – it displays the key to the Minor-axis and Major-axis 
angles. 

 
Figure 5. Angular position echogram in the Echoview  manual EV file template. 
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Cruisetrack 

19. View the position GPS fixes cruise track variable. 

 
Figure 6. Cruise track with GPS fixes. 

20. Observe the GPS fix information in the Color legend 

21. Move over the active window and select Variable Properties on the Shortcut menu. 
View the pages and settings. 
The template file stores the settings: 
Maximum apparent speed: 25 on the Data page. 
On the Display page: 
Show good fixes is selected 
Show scale bar is clear  
As a result, all good fixes are shown and the Scale bar is not displayed. 

Synchronization 

22. Click Vertical tile  

23. Click a variable window and click Auto-synchronization  - this places the 
variable in a synchronization group. 
This is a useful feature to view variables using synchronization cues but it can be 
slow for large data files. Alternatively, you can use Synchronize All Echograms on 
the Shortcut menu. 

Save 

24. On the File menu, click Save As. 

25. Select the folder in which the Echoview manual data has been saved. 
If you used the standard installation settings, this should be 
C:\Myriax\Echoview\Echoview4\Echoview manual 

26. In the Filename box, type a name for your file. 

27. Echoview adds the .EV file extension automatically when you save the file. 

28. Click Save. 



1. View and inspect data          8 

 8 

29. On the File menu click Close. 

 
 Tips and tricks 

Refer to the Echoview Help file for more information regarding the following topics: 

 EV files 

 EV file templates 

 Using EV file templates 

 Filesets 

 Supported echosounders, sonars and data file formats 

 About variables 

 About echograms - for examples of echograms. 

 Echogram tools toolbar – for other useful tools and selection tools. 

 Navigating Echoview 

 About cruise tracks 

 Echoview configuration settings 

 About keyboard shortcuts 

 

Topic completed. 

You can now: 

 Create a new EV file based on a template and add data to it. 

 Create a new EV file and add data to it. 

 View a Raw Variable – Sv, TS, Angular position, GPS fixes 

 Use onscreen sample information: 

 Use selection tools and zoom tools/shortcuts and echogram synchronization. 

 Use of the Variable Properties dialog box for echograms and cruise tracks. 

 Use the Details dialog box 

 Use the Echoview Status bar 

 Use the Information bar 

 Use the Color legend 
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2. Calibration 
What is covered? 

The Calibration topic covers the following steps in the Great Lakes Summary of the SOP. 

1. Enter sound speed, absorption coefficient, and system calibration settings (10.1.2).  

2. Adjust transducer depth.  

3. Synchronize time. 

EK60 and EK500 data files are used as the calibration examples.  

Simrad .DG6 and Biosonics data files demonstrate time synchronization, cruise track/GPS 
and off-transect issues.  

All the described techniques can be applied to any supported data format in Echoview. 

 

Calibration values 

 
Two key parameters for the quantitative analysis of survey data are transducer location and 
transducer calibration values.  

Echoview offers geometry settings for each transducer. 

Echoview offers calibration settings for each variable it derives from your data. 

Be aware that there may be different calibration values for different variables. Even for a 
single variable, calibration values may change between pings. For those reasons, many data 
formats require manual entry of calibration values for each variable – the exception is EK60 
.raw files where you can manually or automatically enter values.  

Ultimately the choice of which calibration values to apply in Echoview is up to you.  

To find calibration values recorded in data files: 

 Inspect data in Echoview. 

 Use Echocheck for supported file formats. 

 Inspect survey logs or other files/recording materials.  

The manual entry of calibration values, as outlined in the steps in this topic, can be used 
with all supported file formats. 
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Platforms, transducers and geometry 

Draft recorded in a EK60 data file 

1. Start Echoview. 

2. On the File menu select Open. 

3. Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\1 View and inspect\My viewing 
data (Solution).EV 
Click Open. 

4. Click Details . 

5. Click the Sv echogram. 

6. Inspect the Ping (from file) section of the Details dialog box. 
Your mouse pointer points to a sample in a ping and the calibration values are 
displayed. One of the values is Transducer draft: 3.5m. 

7. On the Shortcut menu select Variable Properties. 

Calibration and Calibration 2 page 

8. Click the Calibration page. 

9. Observe the setting: 
Apply calibration setting: From first ping  
EK60 .raw files reliably contain calibration values written with the first ping and 
Echoview (as a default) supports using those values for the Calibration, Calibration 2 
and Transducer Calibration pages. 
The setting Manually is available as well. 

Transducer Properties 

10. Click the Transducer Properties tool . 
The Transducer Properties dialog box allows you to enter settings and geometry for 
a transducer associated with your data. 

You can also access Transducers using the Variables and Geometry window  - 
refer to Appendix H: Using virtual variables in Echoview. 

11. Click the Location page. 

12. Enter the Transducer draft 3.5m for Z - Vertical offset (m)  
Observe the View from Starboard and what happens to echograms in the 
background. 

13. Click OK. 
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Data calibration 

14. Close the TS and Angular position echograms and the Cruise track window. 

15. View the Filesets window. 

Add second fileset and EK500 data 

16. On the Fileset menu select New fileset. 

17. In the Filesets Properties dialog box under Name enter EK500. 
Click OK. 

18. Click Add on the Filesets window. 

19. Use the Add Data Files dialog box to find the data file: 
C:\Myriax\Echoview\Echoview4\Echoview manual\2 Calibration\20070104-
162835.ek5, 
Click Open. 

20. In the Filesets – File 1 window, the derived Raw Variablesfro the EK500 fileset are: 

 
Figure 7. EK500 raw variables. 

The EK500 data originates from EK60 echosounder output – it is essentially the 
same data as the file in Fileset 1. However the transducer draft and calibration values 
are not recorded in the EK500 file.  
EK500 data requires the manual entry of calibration values for each variable – 4 
acoustic variables in all. 
 
You will calibrate the Sv power variable in this exercise. 

EK500 Sv power calibration  

21. Double-click the Sv W1 telegrams (power) variable.  

22. View the Sv W1 echogram. 

23. On the Shortcut menu select Variable Properties.  

24. Click the Calibration and then the Calibration 2 page. 

25. Enter the required calibration values using the Table 5: EK60 calibration values. 
The transducer is the same as for the EK60 data so you don’t need to re-enter the 
transducer draft. 

26. Click OK. 

27. Open the: 
EK60 Sv raw pings echogram 
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EK500 Sv power echogram 
Close any other windows. 

Tile Horizontally . 
Zoom in on a fish in one echogram. 
On the Shortcut menu select Synchronize Echograms.  

You may also have to Auto-synchronize  both echograms. 

28. Inspect the information about the same sample in both echograms. 
The values should be the same. 

Save 

29. On the File menu click Close (without saving the file). 

30. Or, on the File menu, click Save As. 

31. Select the folder in which the Echoview manual data have been saved. 
If you used the standard installation settings, this should be 
C:\Myriax\Echoview\Echoview4\Echoview manual 

32. In the Filename box, type Yourname calibration. 

33. Click Save. 

34. On the File menu, click Close. 

HAC data format  

 
Echoview supports a number of file formats. Among them is the HAC data format for 
reading and writing generic tuples. Echoview also supports: 

 EK500 tuples 
 BioSonics 102 tuples 

The Echoview help file discusses issues associated with HAC: 

 Data files 

 Raw variables derived from data  

 Calibration setting for data 
 

Continuity of data 

 
After you calibrate all the raw variables, it is useful to check the continuity of the data with 
respect to time and GPS fixes. Echoview allows you to: 

 correct for differences in data file times  

 test for uncertain GPS fixes  

 identify and mark off-transect data 

Information about the conditions of data collection in survey/scientific logs can assist you in 
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identifying these issues.  

The following exercise examines two sets data files that were recorded simultaneously from 
one vessel, using two different sounders (a BioSonics DT echosounder and a Simrad EY500 
echosounder). The clock on one sounder was fast by 7 hours so the data files do not overlap 
in time. The cruise track contains classic cruise track problems. Only the BioSonics file 
contains GPS fixes. The data were collected in a lake in New York State.  

The exercise omits calibration for expediency and works up the data in a new EV file. If you 
have the time calibrate the variables. The solution file is: 
C:\Myriax\Echoview\Echoview4\Echoview manual\2 Calibration\Continuity of data 
(Solution).EV 

 

Synchronize time 

Two unsynchronized sounders, one sounder turned off for 30 s 

1. Start Echoview. 

2. On the File menu click New. 

3. In the New EV file dialog box, click No template. 
A new EV file is created with default settings. 

4.  On the Filesets – File 1 window click Add. 

5. Use the Add Data Files dialog box to find the .DG6 data files: 
C:\Myriax\Echoview\Echoview4\Echoview manual\2 Calibration\  
10012056.dg6, 10012100.dg6 

6. Select both .DG6 files and click Open. 

7. On the Fileset menu select Fileset Properties. 

8. In the Name section type Simrad 
Click OK. 

9. On the Fileset menu select New Fileset. 
In the Name section type Biosonics 
Click OK. 

10. Click the Biosonics tab and select Add. 

11. Use the Add Data Files dialog box to find the.DT4 data files 
C:\Myriax\Echoview\Echoview4\Echoview manual\2 Calibration\  
62752056.DT4, 62752100.DT4 

12. Select both .DT4 files and click Open. 

Offsets in time, aligning filesets 

13. Display an Sv Echogram from each fileset. 
Minimize all other Echoview windows. 
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Tile horizontally  

Find a common feature 
14. Click the Biosonics Sv echogram. 

On the Display page of the Variable Properties dialog box. 
Color display minimum: -70 
Color display range: 36 
Color scheme: EK500 
Click OK. 

15. Use the mouse wheel to zoom into a feature that is common to both echograms 

 
Figure 8. Zoom on a common feature. 

16. On the Details window note the time of the common feature in each echogram – the 
Biosonics sounder is 7 hours ahead of the Simrad sounder. 

Align the times 
17. Click the Simrad fileset. 

On the Fileset menu select Fileset Properties. 
Under Time offset, select ADD and enter 7 hours. 
Click OK. 

18. Re-examine the common feature, the times should be the same. 

Cruise track problems and GPS fixes 

19. Close the Sv echograms. 
Display the Cruise track from the Biosonics fileset. 
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Figure 9. Cruise track (start and end) on the left hand side; across a large latitude a bad GPS fix on the right hand 

side. 

20. On the Shortcut menu select Variable Properties. 
On the Display page 
Select Show good fixes. 
Clear Show scale bar . 
Click OK. 

21. Zoom on the cruise track (the square on the left hand side).  

 
Figure 10. An elbow in the cruise track; a large jump due to the sounder being switched off  while the vessel was 

relocating. 

22. Display the Biosonics TS echogram. 
Tile vertically. 
Narrow the TS echogram window to one quarter of its width. 
Click on the cruise track window. 
Zoom until you can clearly see the cruise track elbow, use the mouse to point to the 
sharp corner and on the Shortcut menu select Synchronize Echograms. 
 
You will see a discontinuity on the TS echogram. There is a 30 s gap with one file 
(62752056.DT4) before the discontinuity and a second file (62752100.DT4) after the 
discontinuity. 

Test for uncertain track status 
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23. Click on the cruise track window. 
On the Shortcut menu select Variable Properties. 
Under Maximum acceptable gap of the Data page enter 20s. 
Click OK. 
 
The sections of the cruise track that exceed 20s are colored magenta – indicating an 
uncertain position status. The position status is also shown on the echogram. 

Maximum apparent speed 
With a small ship GPS fixes can be more erratic. A large ship can have steadier GPS fixes. 

The Minimum acceptable gap setting can help to smooth the cruise track. 

24. Click on the cruise track window. 
On the Shortcut menu select Variable Properties. 
Under Maximum apparent speed of the Data page enter  
5, then 6, then 7, then 8 knots. 
Click Apply for each setting and observe the changes in the GPS fixes. 
 
Bad GPS fixes are displayed – 5 knots, many bad fixes; 8 knots, no bad fixes. 
 
Survey information (about known bad fixes) and previous experience will help you 
choose a suitable value for the Maximum apparent speed. 

On-transect check 
25. Use survey information to verify the latitude and longitude of the cruise track. 

26. Use survey logs to find out if any echogram data is off-transect. 

Off-transect data 
27. Display the Simrad Sv echogram. 

The data occurring after 2/10/1996 04:10:14:400 has an unknown position status. 

28. Click the Vertical selection tool . 

29. With the mouse pointer select data from 2/10/1996 04:10:14:400 to the end of the 
echogram. 

30. On the Shortcut menu select Define Region. 
On the Region browser: 
Name: Off-transect 
Type: Bad data 
Click Classes. 
On the Regions page, under Region classes click New. 
On the General page of the Region Class Properties dialog box. 
Name: Off-transect. 
Click OK. 
Click OK. 
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Class: Off-transect 
Close the Region browser. 

31. The Off-transect region now appears on every echogram. 

32. On the File menu select Save - if you would like to save your work. 

33. On the File menu select Close. 

 
 Tips and tricks 

1. You can use Echoview virtual variables to calculate calibration constants associated with Calibration 
sphere data. For more information refer to Appendix H From Virtual variables training exercises
Exercise 10: Calculating Calibration Constants in Echoview or refer to the Echoview help file page: 
Using Echoview in the calibration process. 

2. When you use virtual variables you can choose to inherit calibration settings from an available 
variable.  See also the help file topic: Inheritance of properties. 

3. On the Calibration page of the Variable Properties dialog box, the Calculator button opens the Sonar 
Calculator dialog. The Sonar Calculator provides settings for the referenced calculation of Sound 
speed and absorption coefficient for fresh water and sea water.   

4. The setting to show position status on echograms is: 
EV file Properties>Echogram>Show on echogram>Position status. 
Other universal echogram display settings are here too. 

Refer to the Echoview Help file for more information regarding the following topics: 

 Supported echosounders, sonars and file formats 

 About Echocheck. 

 About calibration settings 

 HAC data files 

 About transducer geometry 

 About cruise tracks 

 About Regions 

 

 

Topic completed 

You can now: 

 Calibrate data 

 Use the Fileset offset feature to synchronize file times. 
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 Use Cruise track settings to smooth GPS fixes 

 Use bad data regions to remove off-transect data from analysis.  
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3. Scrutinization 
What is covered? 

The Scrutinization topic covers the following steps in the Great Lakes Summary of the SOP2. 

1. Add a surface exclusion line (10.1.3). 

2. Detect and edit the bottom (10.1.4).  

3. Scrutinize echograms for bad data and remove from the analysis (10.1.5). 

4. Remove ambient noise (10.1.5). 

The Scrutinization stage configures the echogram for the analysis of aggregated and/or single 
biological organisms. It is at this stage that a surface exclusion zone, an acoustic bottom line, 
bad data, background noise and other sources of unwanted echo are characterized and 
accounted for. 

This stage is also useful for determining likely analysis thresholds and the possibility of 
species differentiation in multiple frequency data. 

The exercises begin with a calibrated EV file using the single frequency EK60 data examined 
in Topic 2.  

The Solution file is: 

C:\Myriax\Echoview\Echoview4\Echoview manual\3 Scrutinization\Scrutinization of data 
(Solution).EV 

 

Surface exclusion zone  

 
A surface exclusion zone excludes data from the upper part of the echogram from analysis. 
The zone’s data may be unreliable for one or more of the  following reasons: 

 It is within 2 times the near-field boundary (Rb) of the transducer – between the 
transducer and Rb there is a break down of far field conditions4,5 (2005, 2008). 

 It is affected by physical surface conditions5,6 (2008, 2005) – caused by wind or 
rough weather, or “bergy” bits etc. 

 It is affected by vessel noise/bubbles/cavitation/turbulence5,6 (2008, 2005). 

 It is affected by unwanted biological echo6 (2005). 

 It is affected by transducer “ringdown”. 

Starting points for surface exclusion zone scrutinization are: 

 Appendix E: Working range for far-field conditions. 

 Survey logs 

 Appendix D: Examples of echogram interpretation. 
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 Previous experience. 

The calibration of transducer location in Transducer Properties accounts for transducer 
depth.  

The outcome is the creation of an Echoview line - initially defined at a specified depth and 
possible manually edited for local conditions. The line is used as an “Exclude above line” 
for analysis. 

 

Surface line 

1. Start Echoview. 

2. On the File menu select Open. 

3. Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\3 Scrutinization\Scrutinization 
of data.EV 
Click Open. 
The data in the EV file is calibrated with values from the first ping and transducer 
draft is set to 3.5m. 

4. Use the Horizontal band tool  to zoom in on the top of the Sv echogram. 

 
Figure 11. Top 12m of the Sv echogram. The black band shows the transducer draft (3.5m), the colored banding(3.5 

to 6m) is the ringing of the transducer and there are scattered aggregations of plankton. 

5. For this data the surface exclusion zone includes: 
Transducer draft: 3.5m 
Transducer ringing: 3.5-6m 
2Rb:9.2m (worked example from Appendix E: Working range for far-field 
conditions.) 
The reverberation from aggregations of plankton will be accounted for at another 
step – Removing unwanted reverberation. 
Sea surface conditions are calm and there is an absence of bubbles/cavitation. 

Create a Surface line at 10m 

6. Click the Line draw tool arrow , select New Editable Line. 
On the New Editable Line dialog box: 
Create a new line: Surface line 
Source Fixed depth: 10m 
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Click OK. 
A green line appears at the top of the echogram. 

 

The bottom exclusion zone and the acoustic bottom line  

 
It is important to exclude seabed echo from data used in analysis because the echo strength 
from the seabed is typically orders of magnitude greater that the echo strength from 
biological organisms. 

The acoustic bottom is the line that defines the boundary between samples in a ping that 
contain no significant contribution from the seabed echo and those samples that do contain 
significant contribution from the bottom echo. The line is typically used as the "echo 
integration stop" within a ping or as the "exclude-below line" in Echoview. 

The acoustic bottom line can be based on: 

 A sounder-detected bottom line derived from the data file (where available). 

 A line generated by a bottom detection algorithm in post-processing (line pick 
algorithm). 

 Manual editing. 

 A combination of a any of the above. 

The acoustic bottom line should be set slightly higher than the detected seabed depth to 
avoid including data from the beam dead zone7 (2005) and poorly defined bottoms. A 
suggested offset is 0.5 m but 0.2 to 1 m is acceptable8.(2008)  

The acoustic bottom line must be verified and faults due to failures in equipment or failures 
in the detection algorithms must be corrected – usually by manual editing. 

The following example does not have a sounder-detected bottom line. If there were one that 
is of acceptable quality, you could create an editable line that is a copy of the sounder-
detected bottom line and then work with that. 

e.g. 

Click the Line draw tool arrow , select New Editable Line. 
On the New Editable Line dialog box: 
Create a new line: Copy of sounder-bottom 
Source Existing line: Sounder detected-bottom 
Click OK. 

Diagnostic aids for creating an acoustic bottom line in this EV file are: 

 A Best bottom line pick line  

 An Offset from the line pick line (offset by -2m)  

 A 1000mx50m grid on the echogram 

An analysis has been set up for the space between the line pick of the acoustic bottom and 
an offset line 2m above the line pick. 
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The echogram’s integram is configured to display mean Sv calculated for the analysis. The 
along-track display of the cruise track shows mean Sv of the analysis with respect to the 
echogram grid. 

The aim is to exclude unwanted reverberation (seabed or other) in the line pick for the 
acoustic bottom. Strong mean Sv indicates that a visual inspection and possible edit of the 
line pick is required.  

Appendix G: Hydroacoustic issues associated with acoustic bottom verification is a useful 
guide on the identification of the dead zone, beam side lobe artifacts and biological 
reverberation close to the seabed. 

 

 

Determining the acoustic bottom line  

Along track analysis and the Echogram integram as a bottom exclusion 
diagnostic  

 
Figure 12. Best bottom line pick with a back step of 0.5m. The along- track display shows Mean Sv for 

the 1000m grid. The highlighted Integram shows the mean Sv between the Offset line and 
the Best bottom line pick. The red boxes indicate sections of the line pick that need to be 
verified and manually edited. The line pick algorithm performs poorly in these areas because 
of the nature of the seabed, the beam’s dead zone, beam side-lobe artefacts and the 
presence fish close to the seabed. 

Line pick algorithm 

7. Click EV file Properties  to view the line pick settings. 
Line picking algorithm: Best bottom candidate 
Start depth: 10m 
Click OK. 
Note: The Backstep (default offset for the line) is 0.5m 

8. Click on the Sv echogram. 
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Inspecting the line pick 
9. On the View menu select Cruise track, Copy of Sv. 

10. Tile vertically the Sv echogram and the Copy of Sv cruise track. 
Zoom in to display the seabed and bottom line. 
Click on a colored section of the cruise track.  
On the Shortcut menu select Synchronize echograms. 
 
This method is useful if you have a long transect and you want to quick go to areas 
of concern in the bottom pick in the Sv echogram. 

11. From the beginning through to the end of the echogram, inspect the area around the 
Best Bottom Line Pick line. 
- OR - 
Synchronize to areas of concern using the cruise track as a guide. 
  
Use a combination of  

Rectangle tool  
Zoom (S) 
The echogram window scroll bars. 
 
It will be evident where the Best Bottom line pick fails and needs to be manually 
edited. 

Fixing the Acoustic bottom line – a manual line edit of copy of the line pick 

12. Click the Line draw tool arrow , select New Editable line. 

13. On the New Editable Line dialog box: 
Create a new line: Acoustic bottom line 
Source Existing line: Best bottom line pick (E) 
Offset, Linear function, Multiply depth by: 1.00  
Click OK. 

14. Click the Sv echogram. 
On the Shortcut menu select Variable Properties. 
Click the Analysis page. 
Exclude below line: Acoustic bottom line 
Click OK. 

15. Display the area around the Acoustic bottom line. 

16. Click the Line draw tool arrow , select Acoustic bottom line (to make the 
Acoustic bottom line active). 

The mouse pointer is now in line edit mode . 

17. Inspect the Acoustic bottom line 

18. Freehand draw a new section of line.  
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or  
Make successive clicks to draw straight segments of a new section of line. 
 
To clear a mistake press ESC and begin again. 

19. Merge your line edits with the Acoustic bottom line. 
On the Shortcut menu select Update Active line. 

 
Figure 13. Verified Acoustic bottom line. Note the changes in the Integram display and the along-track mean Sv 

display. Compare with Figure 12. 

 

Regions – types and classes 

 
Regions in Echoview are a feature of the EV file and are specified by depth and time. Once 
defined, a region can be applied to all echograms in an EV file, including virtual echograms. 

Two important properties for regions are: 

 Region type- used to describe the intended use for a region (Analysis region, Bad 
data region or Marker region). 

 Region class - used to group regions for any specified purpose. 
e.g. Plankton surface line to 50m, Fish within 20m of seabed, Shallow schoolers, 
Deep plankton, Vessel noise. 

A bad data region can be used to enclose data (of any type) which is to be excluded from 
analyses. This is a useful way to exclude data that have known problems, such as data 
affected by bad weather, interference, ghost bottoms or echosounder malfunction. 

Analysis regions can be used to enclose/segregate data which is to be included in analysis.
When it is suitable, a 2D schools detection can create a differentiated ‘school’ region. (see 
also Regions, species and classes – automated method using the Echoview Schools detection
module). 

Regions can be used to partition echogram data into classes. Regions must not overlap if you 
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intend to make use of the relationship: 

NASC of a Cell in an echogram = Sum of PRC_NASC of regions in the cell. 

Where NASC is nautical area scattering coefficient and PRC NASC is the Proportioned 
Region to Cell NASC. 

The conditions for this relationship to be true are: 

– the regions fill the cell completely 

– the regions do not overlap with one and another. 

Step 6 of the Great Lakes SOP includes a note to consider “the assumption about fish 
density in bad data regions is important if those regions are large”. 

 

Creating regions 

Bad data regions 
1. Scrutinization of data. EV has no bad data. You do not need to create regions for bad 

data. 

2.  However when you do have bad data you can create regions using any of the 
following selection tools: 

 Rectangle tool  

 Horizontal band tool  

 Vertical band tool  

 Parallelogram tool  

 Polygon tool  

 CTRL+J (create a region for the current ping – the default is a Marker region.) 

3. Once the region is created, on the Shortcut menu select Define Region. 
On the Region Browser: 
Name: Name of region. 
Type: Bad data 
Class: Create a class or Assign a class 
Click OK. 
Bad data regions were created in the section on Off-transect data 

Marker regions 
4. There are two geographic locations: 

SE corner of San Juan Island at ping 53. 
Round Rock at ping 889. 

5. Display the area around the ping (53, 889). 
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6. Place the mouse over the ping. 
Press CTRL+J 

7. On the Region Browser click Classes. 
Under Region Classes, click New. 
Name: Geographic marker. 
Click OK. 
Click OK. 

8. On the Region Browser. 
Name: The geographic location. 
Type: Marker. 
Class: Geographic marker. 
Under the notes section type the geographic location. 
Close the Region Browser. 

9. Repeat step 26 then step 28 for the other location. 

10. Click the EV file Properties tool . 
On the Echogram page select Show on Echogram: Notes for Marker regions. 
Click OK. 

11. Save your EV file. 

12. Close your EV file. 

Analysis regions  
1. On the File menu select Open. 

2. Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\3 Scrutinization\Scrutinization 
and analysis regions.EV 
Click Open. 

3. Press F11 or F12 until the Color Display minimum is -90dB 
4 regions are defined according to the distribution of reverberation from fish and 
plankton. 

4. The creation of the Bottom region is almost finished. The Bottom region should not 
overlap with the Densely Populated region. To satisfactorily finish the creation of 
the Bottom region the region boundary needs to be fixed. 
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Figure 14. Overlap of the Bottom Region with the Densely Populated Region. 

5. Click the Bottom Region. 
Use the mouse wheel to Zoom into the area of concern. 

6. Click the Region Edit tool arrow  and select Draw. 

7. Draw a new boundary line for the Bottom region – follow the lower boundary of the 
Densely Populated Region. 

8. Close the EV file. 

 

Reverberation and noise 
Great Lakes SOP advice 

 
Great Lakes SOP Summary 

7. Remove ambient noise (10.1.5). 

“Calculate noise at 1 m depth in the Sv domain…Noise at 1 m is different for TS and Sv 
data, but can be calculated from each other.” 

The SOP advises the Echoview user to integrate noise levels and subtract them after data 
export. 

Section 10.1.5 of the Great Lakes SOP refers to noise removal techniques for Sv (volume 
scatterers) and TS (single scatterers). 
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Characterization of reverberation and noise 

 
In their discussion on echo detection, Simmonds and MacLennan6 discuss reverberation 
and noise. 

“Reverberation is the general term used to describe echoes from unwanted targets.” As a 
consequence, the echoes that you attribute to reverberation are dependent on the purpose 
of the analysis or survey. If you intend to study fish, then echoes from plankton are 
reverberation. Conversely, if you intend to study plankton, echoes from fish are 
reverberation. 

On the other hand noise is the term used to describe “unwanted signals that are present in 
the medium but independent of the echosounder transmission”.  

This ‘background noise’ can come from: 

 Vessel sources e.g. propeller cavitation, machinery, electrical interference etc 

 Changes with water depth 

 Flow noise 

 Animals, rain, wind, waves 

 Electrical noise from echosounder hardware 

Things that affect signal and noise  

The choice of transducer frequency dictates the maximum working range and the type of 
observations you can make9 (2005). Frequency also constrains beam width and pulse 
length which affect resolution. Similarly, the absorption coefficient in the medium affects 
the signal to noise ratio (SNR)10 (2005). 

TS data is affected by an r4 reduction in signal with range, and Sv data is affected by an r2 
signal reduction with range. 

The preceding considerations can give you a starting point for the likely SNR and 
background noise in your data. 

Multiple frequencies 

Multiple frequencies can be used to differentiate reverberation and wanted echoes – if 
there are useful frequency responses to exploit. With multiple frequency data, background 
noise removal is very important. For more information refer to 5. Multiple frequency data. 

Noise removal strategies 

Characterize your noise 
Graph a ping to determine: 
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 the nature of the noise 

 the magnitude of the wanted echo 

 the magnitude of the reverberation. 

 
Figure 15. (Above) Graph of a single ping (blue) and TVG function 

(pink). Highlighted 1: plankton reverberation. Highlighted 2: 
desired echo. Highlighted 3: desired echo. 
 
(Right) 120kHz echogram with color striping due to the 
TVG function – this data is a good candidate for 
background noise subtraction. 

 

 

 

 

Figure 16. Noise removal and threshold strategies. 
The pink line is the ‘TVG’ noise – if this is subtracted the wanted echo and plankton reverberation 
remain. 
 
Threshold 1 removes the plankton reverberation and some of the wanted echo at -80dB, however ‘TVG’ 
noise remains for echo below 450m. 
 
Threshold 2 removes all echoes below -54dB; ‘TVG” noise remains for echo below 800m. 
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When SNR is >>15dB you can use a constant data threshold or a TVT threshold (where 
the noise at 1m is determined empirically). Thresholds allow you to ignore noise below a 
set value however a certain proportion of the noise can remain. The larger the SNR, the 
smaller the proportion of remaining noise. Another drawback is that any wanted signal 
below the threshold is ignored. 

When SNR is moderate to poor the best strategy is to model the noise and subtract it. 

Echoview noise and reverberation features 
Echoview offers features (that do not require the Virtual echogram module) to: 

 Calculate background noise analysis variables (to export) to use in downstream 
analysis outside of Echoview. 

 Threshold or filter acoustic data used for analysis. 
On the Data page of the Variable Properties dialog box available features can 
include: 

 Minimum and maximum thresholds 

 Minimum TS threshold 

 Time varied threshold (TVT) 

With Echoview’s Virtual echogram module you can use operators that apply more 
complex threshold(s), model TVG noise and subtract modeled noise. 

 Data generator operator - creates pings to specified settings and ping geometry – 
useful in modeling TVG noise and in background noise subtraction methods 
(when used with the Linear minus operator). 

 Threshold operator – compares data values from two variables. 

Another useful feature is the Threshold response graph, where you can view the effect of 
threshold Sv value (X axis) versus the resulting NASC (Y axis). The graph can be linked 
to a selection or region and display the threshold response of a single variable or multiple 
variables. 

Whatever the mix of single target scatterers and volume scatterers, the background noise 
removal/minimization and reverberation removal strategies you use will need to be 
optimized. The optimization process is in effect a sensitivity study. 

Finally, you need to consider the effects of under-estimation or over-estimation of the 
analysis results due to the noise and reverberation strategies you used. 
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Noise and reverberation analysis 

1. Start Echoview. 

2. On the File menu select 
Open. 

3. Browse to: 
C:\Myriax\Echoview\E
choview4\Echoview 
manual\3 
Scrutinization\Noise 
and reverberation 
analysis.EV 
Click Open. 

4. Display the 120 kHz Sv 
echogram. 

5. Zoom in so that you 
can see ping 599 and 
the fish highlighted in 
Figure 17. 

6. Point to ping 599. 
On the Shortcut menu 
select Graph Ping. 

 

Figure 17. Graph of ping 599 in the Noise and reverberation 
analysis.EV file.  

7. Observe the features of the ping graph, as labeled in Figure 17. 
The peak Sv for the fish and fish aggregations are greater than 10dB above the 
plankton and noise. There is also no indication of “TVG’ curve in the slope of the 
noise. 
 
If you are interested in fish, a threshold for the reverberation from plankton is 
appropriate here. 

Threshold response graph 
8. To determine the correct threshold to apply, you can observe the effect of a threshold 

value on integration results. 

9. Close the ping graph. 

10. On the Shortcut menu select Variable Properties. 
Click the Analysis page 
Exclude above line: Surface line 
Exclude below line: Acoustic bottom line 
Click OK 
 

11. On the View menu select Graph, Threshold response.  
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(Step 11 configures the Threshold response graph) 
On the Shortcut menu select Properties 
Under Variable select 120 kHz 
Under X axis limits 
Select Custom limits 
Minimum: -100.00 
Maximum: -30.00 
Steps: Maximum 
Click OK. 

12. On the Graph menu select Linking, Selection. 

13. Click the Horizontal band tool 
On the 120 kHz echogram, 
Make a selection: 
From the Surface line to the seabed. 

 
Figure 18. Threshold response for the 120 kHz Sv echogram – the echograms to the right show the display threshold 

at -80 dB (plankton and fish), -70 dB (fish) and -55 dB (fish or fish aggregations with strong signal). 

14. Observations from the ping graph, the Threshold response graph and varying the 
Color display minimum suggest that much of the plankton can be removed with a 
threshold set at -70dB. This leaves a small amount of plankton, the fish and fish 
aggregations. If you are interested in the fish aggregations with very strong signal a 
threshold of -55 dB can be used. 

Data threshold and integration results 
15. Close the Threshold graph. 

16. Using the Horizontal selection tool 
Make a selection from the surface line to the seabed 

17. On the Shortcut menu click Integrate selection. 
On the Integration results dialog box, click Linked  
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Note: NASC is 124.03. 

18. On the Shortcut menu select Variable Properties. 
Click the Data page 
Under Minimum threshold select Apply. 
Clear Lock to Color display minimum and enter -70dB as the minimum threshold. 
Click Apply. 
 
Note: NASC is 101.30. 

19. The choice of a minimum threshold of -70 dB is a compromise – it removes most 
but not all of the plankton data and maximizes the fish data. 

20. Close the EV file (without saving). 

 

Noise subtraction using virtual variables 

 
The next set of instructions use virtual variables to estimate and subtract background 
‘TVG’noise for a simple example. While another example of the subtraction of background 
noise and reverberation using virtual variables (multiple frequencies) can be found in the 
section The dB difference technique implemented using virtual variables. 

For more information about the estimation of echosounder background-noise levels and 
SNR, refer to De Robertis and Higginbottom11(2007) for their discussion of a “simple and 
effective post-processing technique to estimate echosounder background-noise levels and 
SNR …”. 

 

 
Figure 19. Sv echograms from the Background noise subtraction .EV file. Sv+noise, Data generator modeling 

TVG noise, Sv – noise. 
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Figure 20. Ping graph of ping 332 in Sv + noise 

echogram. 

 
Figure 21. Ping graph of ping 332 in  

(Sv – noise) echogram. 
 

 

 
Figure 22. Virtual variable chain for background noise subtraction. 

1. Start Echoview. 

2. On the File menu select Open. 

3. Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\3 Scrutinization\Background 
noise subtraction.EV 
Click Open. 

4. Display the Sv echogram. 
Display the Ping graph for ping 332 
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The echogram and the ping graph shows the wanted echo, echo from the seabed and 
‘TVG’ noise as displayed in Figure 19 and 20. 
 
Two regions have been created in “quiet” parts of the echogram – at the top and 
below the seabed. The regions can be useful (for integrations) in the investigation of 
noise and wanted echo. 

Model the TVG noise with the Data generator operator 
If you haven’t used Echoview virtual variables before, we advise you to do some pre-
reading with Appendix H: Using virtual variables in Echoview. 

5. Click the Variables and Geometry tool . 
On the All page 
On the Shortcut menu select New, Variable. 
Name: Noise estimate) 
Operator: Data generator 
Click OK. 
On the Operands page 
Operand1: Primary fileset Sv Q3 telegrams (i.e. uses the ping geometry of this Sv 
variable). 
On the Generator page 
Output type: Sv 
Algorithm: Constant + TVG curve 
Sv at 1m: -109.9 (arrived at by previous observation - of the effect of TVT threshold 
on Sv). 
Click OK. 

Subtract the Noise estimate from the Sv variable 
6. On the Shortcut menu select New, Variable. 

Name: Sv removed noise 
Operator: Linear minus 
Click OK. 
On the Operands page 
Operand 1: Primary fileset Sv Q3 telegrams  
Operand 2: Noise estimate 
Click OK. 

7. Display the Noise estimate variable and the Sv removed noise variable. 
Arrange the echograms so that you can see all of them (See Figure 19). 

8. On the Noise estimate echogram 
On the Shortcut menu select Variable Properties. 
Change the Sv at 1m value, click Apply and observe the changes in the Sv removed 
noise echogram. 
 
A ping graph of a ping running through a school can be useful in this optimization 
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process. (See Figure 21). 

9. Save your EV file under a different name. 

 
 Tips and tricks 

Refer to the Echoview Help file for more information regarding: 

 Integram 

 Along-track cruise track display 

 About lines 

  or  can be used with the Shortcut menu Define line-relative regions, and Region edit 

tools  to create regions incorporating lines like the acoustic bottom line. 

 Region class. 

 Region type. 

 Ping graph. 

 Threshold response graph 

 About NASC and PRC NASC 

 

Topic completed 

You can now: 

 Create and edit a surface line. 

 Create and edit an acoustic bottom line 

 Assess your data for wanted echo, unwanted echo and noise. 

 Remove noise and reverberation from analysis. 

 

 



4. Analysis           37 

 37

4. Analysis 
What is covered? 

This topic covers Sv and TS analysis and single target and fish track analysis. 

Also covered are the following steps in the Great Lakes Summary of the SOP. 

1. Extract TS data from single echo detections (10.2). 

2. Study the TS distribution at different depths (10.4). 

3. Set the minimum TS of interest (10.4.2 and 10.4.3). 

4. Set the integration threshold (10.4.4). 

5. Choose the size of the analysis cell (10.3). 

 

Analysis strategies 

 
The View and inspect, Calibration and Scrutinization stages can give you some 
insight into the type of analyses you can perform on data. 

For Sv data, where echoes cannot be resolved into single echoes, analysis using echo 
integration is appropriate. It may also be possible to characterize the composition of 
aggregations. Sv and mean TS (via trawl or direct measurement of single fish) can be 
used to calculate density and in the end biomass. 

Analysis regions can be manually defined. Alternatively, if you have the Echoview 
Schools detection module analysis regions can be automatically detected. 

For Sv data where echoes are single targets (one fish in the beam), analysis using 
single target detection or echo counting is appropriate. In riverine data fish track 
analysis can be applied to estimate fish flux. 

Further options become available when you have concurrent multiple frequency data. 
Where biological scatterers exhibit different frequency responses you can use 
multiple frequency techniques to clearly differentiate echoes from different species.
(For more information refer to 5. Multiple frequency data.) 
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Sv analysis 
Regions, species and classes – manual method 

 
Figure 23. Analysis region classes.EV SvQ1 telegrams T1 echogram – the regions do not overlap. 

Top: Small schools analysis region, Shallow class. 
Middle: Large Schools analysis region, 500m class. 
Bottom: Deep Plankton analysis region, Deep class.  

The Analysis region classes.EV file uses a set of data files collected in Alaska on a Simrad 
echosounder and processed with Simrad’s BI500 software. In this file, the depth range of 
the sounder was increased in four steps as the vessel moved from shallow water to deeper 
water (150 m then 250 m then 500 m then 1000 m). 

Some of the features that have been created are: 

 a surface line called Top 

 an acoustic bottom line called Echoview Bottom 

 bad data regions 

 analysis regions (that do not overlap) 

 large cells (for training purposes) 

The regions and region classes were created using the techniques described in  

Creating regions. 
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1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Analysis region 
classes.EV 
Click Open 

3. View the Sv Q1 telegrams T1 echogram. 

4. Click the Region Browser tool . 

5. On the echogram, click the regions in turn (see Figure 17) and view the region name, 
region type and region class. 

  
Figure 24. Details of regions 

 

6. Close the EV file. 

 

Regions, species and classes – automated method using the Echoview Schools 
detection module 

 
Figure 25. Schools detection on the echogram data for Figure 17.  

The Schools detection (Solution).EV file uses same data files as the Analysis region 
classes.EV file.  

Some of the features that have been created are: 

 a surface line called Top 

 an acoustic bottom line called Echoview Bottom 
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 bad data regions 

 school regions as a result of applying the schools detection algorithm to successive 
selections of the echogram data. 

One of the advantages of using schools detection is that the regions describing the schools 
enclose the echo trace produced by the school more precisely than the manual approach. 
Echoview can then calculate properties of the detected schools. 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Analysis region 
classes.EV 
Click Open 

3. Display the SvQ1 telegrams T1 echogram 

Delete the analysis regions 
4. On the Echogram menu click Region Manager 

Under the Region type list, select Analysis  
In the Action section, click Delete regions 
Click Yes 
Click OK 

Configure Schools Detection 

Set a data threshold 
5. On the Shortcut menu select Variable Properties 

On the Data page, select Apply under Minimum threshold 
On the Display page, under the Color display minimum enter -75 dB 
Click OK 

Set the linking distances 
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Figure 26. Schools page of the EV File Properties dialog box – settings for schools detection. 

6. Click the EV File Properties tool  
On the Schools page 
Maximum vertical linking distance = 20 m 
Maximum horizontal linking distance = 50 m 
Click OK. 
 
Note:  
1. Schools detection needs a data threshold to be specified. 
2. This data file spans relatively large distances between pings so you must adjust 
the linking distances to prevent the creation of disconnected schools. You can to 
experiment with lower linking distances to see the effect of linking distance. 

Detect Schools – regions and classes 

Class 500m 

7. Click the Horizontal band tool  
Select a band from about 300m depth to 650m depth 
On the Shortcut menu click Detect Schools 
In the Assign class list, click 500m 
Click Detect 

Class Deep 

8. Click the Horizontal band tool  
Select a band from about 650m depth to 1000m depth 
On the Shortcut menu click Detect Schools 
In the Assign class list, click Deep 
Click Detect 
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Class Shallow 

9. Click the Horizontal band tool  
Select a band from about 0m depth to 300m depth 
On the Shortcut menu click Detect Schools 
In the Assign class list, click Shallow 
Click Detect 

Analyze schools – export schools variables 

Specify export settings 

10. Click the EV File Properties tool  
On the Export page 
Under the Integration schools group select: 
 
Uncorrected_thickness  
Uncorrected_area  
Corrected thickness  
Corrected_area  
 
and clear: 
3D_school_volume 
 
Also clear: 
Noise_Sv_1m (Integration settings group) 
Minimum_Sv_threshold_applied (Integration settings group 
Maximum_Sv_threshold_applied (Integration settings group 
Standard_deviation (Integration results group) 
Exclude_below_line_range_mean (Analysis domain group) 
Exclude_above_line_range_mean (Analysis domain group)  
Click OK 

Export a school analysis 

11. On the Echogram menu select Export, Analysis by Regions, Integration 

12. In the Export regions with this class list select 500m 

13. Click Export 

14. File name = 500m schools 

15. Save the EV file with a new file name. 

16. Close the EV file. 

17. Examine the 500m schools.csv file in Excel. 
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Size of the analysis cell 

 
For aggregated echoes in detected schools or in manually defined regions, the size of the 
analysis cell can be used to differentiate the variation of mean Sv in the aggregation. For 
example, when aggregations are more than a few hundred meters in extent, smaller cells are 
useful in capturing mean variations in Sv. The results can then be correlated with companion 
species or species age or species size. 

 

Integration – on screen 

Integrate a cell 
1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Analysis region 
classes.EV 
Click Open 

3. View the SvQ1 telegrams T1 echogram. 

4. Move the mouse pointer over the start of the 500m region. 
On the Shortcut menu select Integrate Cell. 
The results are shown on the Integration results dialog. 

 
Figure 27. On screen analysis:  cell integration. 

Integrate a region 
5. Press Esc. 

Select the 500m region. 
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On the Shortcut menu select Integrate Region. 
The results are shown on the Integration results dialog. 

 
Figure 28. On screen analysis: region integration. 

Integrate a selection 
6. Click above the line Top. 

Press Esc. 

Click on the Rectangular selection tool  
Draw a rectangle over an area of high Sv. 
On the Shortcut menu select Integrate Selection. 
The results are shown on the Integration results dialog. 

 
Figure 29. On screen analysis: selection integration. 

7. Echoview offers a range of onscreen integration features. These can be accessed by 
the Shortcut menu and the Display page of the Variable Properties dialog box. 

8. Close the EV file. 
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Single targets 

 
Clues to identifying the presence of single targets in your data are: 

 Crescent shaped or wavy shaped (from crescents plus platform movement) groups 
of samples. 

 Samples that look like fish tracks 

  

Figure 30. Left – an example of crescent shaped groups (Ex60 38 kHz data) 
Right – an example of wavy shaped groups (Ex60 38 kHz data)  

 

Single target detection algorithms extract data that satisfy detection criteria but not all the 
identified targets may be valid single targets12, 13, 14 (2005, 1996, 2001). 

It is not possible to obtain valid TS distributions from within dense fish schools using 
acoustic data. This is because there is always more than one fish inside the sampling volume 
(unless of course the "school" has a sufficiently low density so that the condition of having a 
single fish in the sampling volume is fulfilled). This is one of the classic problems of 
fisheries acoustics. 

 

Single targets data type 

 
A ‘single target’ in Echoview is the representation of an acoustic echo attributed to a single 
backscattering target detected within the beam of an echosounder. Each single target has a 
number of properties: Target Strength and range from the transducer are notable, but many 
other properties are available for analysis. 

Single targets are represented on echograms as colored rectangles. The rectangles are 
displayed with the width of the ping in which the target was detected and a thickness 
(height) which is defined as a function of the transmitted or received pulse lengths. 

Single target detection raw variables can be derived from data (if they are available). 
Otherwise Echoview offers single target detection algorithms that you apply to your data 
using virtual variables. 

Echoview also offers single target data manipulation operators for advanced analysis. 
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Extract TS data from single echo detection 

 
Great Lakes SOP Summary 

8. Extract TS data from single echo detection (10.2). 

“Run single echo or target detection algorithms. Use the same method when measuring TS 
of the calibration ball (EV)….” 

 

 

Study TS distribution at different depths 

 
Great Lakes SOP Summary 

9. Study the TS distribution at different depths (10.4). 

“Use the TS versus Depth graph. Note that changes in TS distribution with depth may 
indicate a change in fish species or age group composition with depth or a bias related to the 
sampling volume and number of targets. Compare different regions of the lake (nearshore, 
offshore). Define depth layers for analysis based on this TS graph. The data should be 
analyzed in depth layers with as homogeneous fish species and size structure as possible. 
Different depth regions may have to be used in different parts of the lake.” 

 

Single target detection raw variables – from EK500 data 

 
Figure 31. Single target detections E1 telegrams T1 echogram, Display thickness is 0.5. The single target and single 

target properties are highlighted. 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Single targets in 
EK500 data.EV 
Click Open. 
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3. On the Filesets window, view the Filesets1 page. 
Echoview derives a raw variable, from the EK500 data, called single target 
detections E1 telegrams T1. 

4. Display the single target detections E1 telegrams T1 echogram. 
Observe the single targets. 
Note: To the eye some of the single targets display plausible lines of movement – it 
would be useful to apply a fish track detection algorithm to this data. 

5. Zoom in so that you can clearly distinguish the single targets. 
Place the mouse pointer over a single target and observe the single target properties 
in the Details dialog box. 

6. Close the EV file. 

 

Single target detection virtual variables via TS and angular position from EK60 
data  

Echoview derives TS and angular position raw variables from the EK60 data in the 
following EV file. The recommended single target detection algorithm for this data is a 
split beam method 2 algorithm.  

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\3 Scrutinization\Scrutinization 
of data (Solution).EV 

3. Click the Variables and Geometry window. 
On the Shortcut menu select View, New View. 
On the Shortcut menu select View, View Properties. 
Under Name enter Single target detection. 
Click OK. 

Single target detection algorithm 
4. On the newly created Single target detection view. 

On the Shortcut menu select New, Variable. 
Under operator select Single target detection – split beam (method 2) 
Click OK 
On the Operands page: 
Operand 1: Fileset1 TS raw pings T1 
Operand 2: Fileset1 angular position raw pings T1 
 
On the Single Target Detection page 
TS threshold: -50 
Pulse length determination level: 6.00 
Minimum normalized pulse length: 0.50 
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Maximum normalized pulse length: 1.00 
Beam compensation model: Simrad LOBE 
Maximum beam compensation: 25.00 
Minor-axis angles: 0.5 
Major axis angles: 0.5 
Exclude targets above line: Surface line 
Exclude targets below line: Acoustic bottom line 
 
On the Analysis page 
Exclude above line: Surface line 
Exclude below line: Acoustic bottom line 
Click OK. 

5. Double click the Single target detection (split beam) method 2 1 variable to display 
the single targets echogram. 

 
Figure 32. Single target detection echogram. 

Tuning the single target detection settings 

Tuning the settings for single target detection involves testing the sensitivity and 
effectiveness of the algorithm settings on the Single target detection page of the Variable 
Properties dialog box. 

Initially, widen up all the single target detection parameters with the exception of the Pulse 
length determination level. 

This involves lowering: 

 TS Threshold (to the minimum of -120 dB), 

 Minimum normalized pulse length (to the minimum of 0.01), 

and raising: 

 Maximum normalized pulse length (to the maximum of 10), 

 Maximum beam compensation (to the maximum of 35 dB), 
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 Maximum standard deviation of minor-axis angle (to the maximum of 45°), 

 Maximum standard deviation of major-axis angle (to the maximum of 45°) 

until as many targets are detected as possible. Then study the effectiveness of the settings 
and the resulting detected targets. 

Frequency Distribution 

6. Display the TS echogram. 
On the Shortcut menu select Variable Properties. 
On the Analysis page 
Exclude above line: Surface line 
Exclude below line: Acoustic bottom line 
Click OK. 
 

Click the Horizontal band tool  
Select a band from the Surface line to the seabed 
On the Shortcut menu select Graph Selection, Frequency Distribution. 

 
Figure 33. TS frequency distribution in a horizontal selection – TS echogram. 

Study the TS  
The following graphs are available for regions or selections. The Frequency distribution 
graph is available for single-beam variables. 

TS Frequency Distribution 

7. Display the Single target detection (split beam) method 2 1 echogram (this echogram 
is used for all the steps in the Study the TS section.). 

Click the Horizontal band tool  
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Select a band from the Surface line to the seabed 
On the Shortcut menu select Graph Selection, TS Frequency Distribution. 

 
Figure 34. TS frequency distribution of single targets in a horizontal selection. 

TS Depth 

8. Click the Horizontal band tool  
Select a band from the Surface line to the seabed 
On the Shortcut menu select Graph Selection, TS vs. Depth 

 
Figure 35. TS vs. Depth graph. 

Angles 

9. Click on the Bottom region. 
On the Shortcut menu select Graph Region, Angles. 
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Figure 36. Angles graph. 

2D Projections 

10. Click on the Bottom region. 
On the Shortcut menu select Graph Region, 2D Projections. 

 
Figure 37. 2D projections graph 

3D Single targets graph 

11. Draw a rectangular selection around a crescent shaped group of single targets 
On the Shortcut menu select Graph Selection, 3D Single targets 
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Figure 38. Above: a rectangular selection around a 

crescent shaped group of single targets 
 
Right: 3D single targets graph of single 
targets relative to the beam. 

 

  

 

Set the minimum TS of interest 

 
Great Lakes SOP Summary 

10. Set the minimum TS of interest (10.4.2 and 10.4.3). 

“Based on the measured TS distribution and/or known TS distribution of the fish species of 
interest, set the minimum TS. Check the TS distribution down to -75 dB to see if smaller 
targets are likely to be included in the fish TS range. Common values for minimum TS of 
interest range from -65 to -55 dB, but this depends on survey species or age-class.” 

Information about the TS distribution can come from relevant literature or previous surveys. 

 

Minimum TS for the Scrutinization example 

The fish we are interested in lie in the Densely Populated region and the Bottom region. 
Observations of the data while the display threshold is varied on the TS echogram suggest 
that the TS threshold for our fish is -50dB. We have used -50dB as a TS threshold value 
for the single target detection algorithm.  

 

Set the integration threshold (TS threshold on an Sv echogram) 

 
Great Lakes SOP summary 

11. Set the integration threshold (10.4.4).  

“The integration threshold should be set to 6 dB below the minimum TS threshold (in the TS 
domain) to account for observations of all targets above the minimum TS within the half 
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power beam width.…If it is not possible to set a TS based threshold for integration, choose a 
lower Sv threshold of -80 dB.” 

Echoview can apply a TS threshold to Sv data (on an Sv echogram). The intent of such a 
threshold is to remove samples below a specified TS value. Echoview’s algorithm uses the 
Sv equivalent of the TS threshold in its calculations, so that samples are thresholded out in 
an unbiased way. 

 

Integration threshold for the Scrutinization example. 

12. Display the Sv echogram. 
On the Shortcut menu select Variable Properties. 
On the Data page: 
Under Minimum TS threshold 
Select Apply 
TS threshold: -56dB 
 
Click TS TVG correction settings 
TVG range correction method: Simrad EX60 default 
Click OK. 
Click OK. 

Figure 39. Sv echogram, no TS threshold. Figure 40. Sv echogram, TS threshold = -56dB 
 

 

Size of the analysis cell 

 
Great Lakes SOP Summary 

12. Choose the size of the analysis cell (10.3). 

“This should include 20 to 50 single fish echoes in most cells. We suggest 200 to 500 m 
long horizontal bins. Range (depth) layers need to be chosen given the fish distributions (see 
step 10). Integration bins could be shorter if using geostatistics and fish are abundant, or 
longer if few fish are present. If the depth layers are small, the horizontal distance may need 
to be increased to get sufficient number of targets in the analysis cells.” 
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Size of the analysis cell for the Scrutinization of data example 

13. Display the Single target detection echogram. 
On the Shortcut menu select Variable Properties. 
On the Grid page: 
Under Show time/distance grid select GPS distance (m) 
Distance between grid lines: 250m 
Under Show depth/range grid select Depth/range 
Separation: 25m 
Click OK. 

14. Use rectangular selections and the TS Depth graph or the TS Frequency 
Distribution graph to count the number of single targets in the cells of interest.  

15. When you achieve a satisfactory cell size, enter the grid values on the Grid page of 
the Variable Properties dialog box for the Sv variable. 

16. Save your EV file. 

17. Close the EV file. 

 

Fish tracking 

 

Fish track detection is used to identify groups of single targets that show a pattern of 
systematic movement. The targets grouped into a fish track are assumed to have been 
generated by a single object moving through space. 
Echoview's �-�  Fish Tracker algorithm implements a fixed coefficient filtering method as 
presented in Blackman15 (1986) and discussed by Dawson and Mulligan16 (2000). 
Behaviors in single target data that suggest fish track detection and analysis would be 
useful include: 

 Single targets that show a pattern of systematic movement to the eye. 
 Single targets that occur in groups shaped like crescents or waves (an effect of 

transducer/platform movement on the crescent shape). 

Available algorithms 
Echoview offers the choice of two fish track detection algorithms: 

 The 2D algorithm uses the range and time information of the single targets. 
Choose this option if your data is from a single beam or dual beam echosounder. 
You can also choose this option if you want the detection to disregard the angles 
in split beam data - all targets will be treated as if they were at the centre of the 
beam. 

 The 4D algorithm is intended for use with split beam data and uses the angular 
position information of the targets in the beam in addition to the range and time. 
It is also used with data from mobile surveys. 

The fish track detection process 
The identification of single targets as fish track candidates and the formation of fish tracks 
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can be optimized with the following settings: 

Track detection: alpha and beta 
Alpha is sensitive to unpredicted changes in position or speed of the target. Beta is 
sensitive to unpredicted changes in velocity of the target. 
For a target that swims or travels in a highly predictable fashion use low alpha and beta 
values. Conversely, for more erratic target behavior use high alpha and beta values.  

Target gate  
These settings specify how large a candidate track’s acceptance gate for predicted single 
target movement is in time and space. 

Weighting 
Assigns a degree of importance to the predicted and observed difference for the candidate 
single target in TS, minor-axis, major-axis, range or time. Weighting can be applied for 
all, some or none of these. 

Track acceptance  
Criteria for an acceptable fish track. 

Tuning fish track detection 
Empirical tuning of fish detection can be done by: 

 Visual inspection – on screen. 
 Detecting tracks with a set of parameters and assigning the results to a region 

class. This can be done any number of times. The results can then be exported 
and analyzed. 

Editing fish tracks and manual classification 
Echoview provides powerful fish track editing and manual classification features. They 
are provided by the: 

Fish track tool   

 Split and Merge fish tracks 

 Remove and Add Target(s) from/to a fish track 

 Delete and Create fish tracks 

Region edit tool . 

 Edit a fish track region using the Region Edit Tool 
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Fish track detection 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Single target 
detection (Solution).EV 
Click Open. 

3. Display the Single target detection (split beam) method 2 1 virtual echogram. 

4. Click the EV File Properties tool . 
On the Echogram page under Show on Echogram clear Region names and Region 
classes. 
Click OK. 

5. On the Echogram menu select Detect Fish Tracks. 
Note: You can detect fish tracks on the whole echogram or on a selection. 

Create a Region class and set detection parameters – tuning using empirical 
results 

6. Under Assign class, click Edit. 
Under Region classes click New. 
Under Name enter Alpha 0.5 Beta 0.5. 
Click OK. 
Click OK. 
Under Assign class select Alpha 0.5 Beta 0.5 from the list. 
 
Click Properties. 
On the Algorithm page 
Under Data select 4D (range, angles and time) 
Under Track detection 
Alpha: 0.5, 0.5, 0.5 
Beta: 0.5, 0.5, 0.5 
 
Under Target gates 
Exclusion distance: 9.00, 9.00, 1.00 
Missed ping expansion: 0.0, 0.0, 0.0 
 
On the Weights page 
Major axis: 30 
Minor axis: 30 
Range: 40 
TS: 5 
Ping gap: 0 
 
On the Track Acceptance page 
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Minimum number of single targets in a track: 3 
Minimum number pings in a track: 3 
Maximum gap between single targets: 3 
Click OK. 
 
Click Detect. 
 
Note: You can tune the detection empirically by repeating step 6 using a different set 
of parameters and region class. Examine the region classes by on screen analysis 
(Shortcut menu>Analyze fish track) or export the results and analyze ( see also 
Exporting TS data – the Fish tracking.EV example). 

7. Display the Sv echogram.  
Tile horizontally. 

8. On the Single target detection echogram, zoom in on the Bottom region. 
On the Shortcut menu select Synchronize all echograms. 

 
Figure 41. Top: Single target detection echogram. Bottom: Sv echogram. Both echograms are synchronized and 

display data in the Bottom region. A detected (and active) fish track region16 is highlighted – fish 
track regions (colored and thick border) enclose single targets in a fish track. 

Fish track tool 

9. Click the Fish track edit tool . 

10. Click the Region Browser . 
On the Single target detection echogram, click on Fish track region16. 

11. Point to the brown single target at ping 522 to the right of fish track region16. 
On the Shortcut menu select Add Target. 
Fish track region16 extends to include the single target. 
Note: There are many other commands to edit and manually create fish track 
regions. 
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Figure 42. Fish track region16 and Fish track editing features on the Shortcut menu – only available when the Fish track 

edit tool  is selected. 

 

Fish track analysis  
12. You can analyze fish track regions with: 

 any of the TS graphs (cross ref to Study TS section) 

 Shortcut menu > Analyze Fish Track 

 
Figure 43. Fish track region16 and Fish Track Analysis Results and 3D single targets graph. 

13. Save your work under a different file name. 
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14. Close the EV file. 

 
 Tips and tricks 

Refer to the Echoview Help file for more information regarding: 

 About regions 

 How to detect and work with schools – Using single, split or dual beam data 

 The Variables and Geometry window 

 How to detect and work with single targets 

 How to detect and work with fish tracks 

 

Topic completed 

You can now: 

 Recognize the type of analysis that is appropriate for your data. 

 Partition data with manual regions. 

 Partition data with 2D schools detection regions. 

 Use on screen integration features. 

 Apply single target detection algorithms in Echoview. 

 Use the TS frequency distribution graph and other TS study graphs 

 Specify analysis cells. 

 Apply a TS threshold for Sv data. 

 Apply fish track detection to your data 
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5. Multiple frequency data 
What is covered? 

A dB differencing technique is discussed and implemented in Echoview. The example uses 
EK60 38 kHz and 120k kHz data: 

 

Frequency differencing 

 
You can use concurrently recorded multiple frequency data and dB difference techniques to 
differentiate the mean volume back scatter of species. Several discussions appears in 
Simmonds and MacLennan17, 18 (2005) and work on the subject can be found in papers by 
Mitson et al19 (1996), Kang et al20 (2002) and Korneliussen and Ona21 (2003). 

The basic idea is that target strength is dependent on frequency in different ways for 
different species. Therefore two species of scatterers (e.g. fish and zooplankton) will, on 
average, have different mean backscattering strengths at different frequencies. Since the 
difference is in the mean backscatter it is usual to average the backscatter in cells or regions 
prior to calculating the dB difference. 

This is applied to multiple frequencies allowing a better definition of the frequency response 
for the classification. 

 
Figure 44. Figure from Korneliussen and Ona21  

When you use dB difference techniques, obtaining unbiased measurements requires high 
signal-to-noise ratio at multiple frequencies. Therefore you need to avoid the integration of 
noise even for one frequency. As a consequence the technique is limited to the range at 
which the highest frequency has a good SNR. Refer to De Robertis and Higginbottom22

(2007) for an approach to this subject. 
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The dB difference technique implemented using virtual variables 

In this example we use virtual variables to create a “dB difference” echogram and then 
classify areas of the original echogram according to specified dB difference criteria. 

It illustrates the use of various virtual operators to implement a typical approach to dB 
differencing. The procedure outlined is not necessarily complete or applicable to any 
particular species classification task. You are referred to the scientific literature for 
working examples of this type of analysis. 

 
Figure 45. Sv echograms of EK60 data from a 38 kHz and a 120 kHz transceiver. The color display minimum is -

90dB for both echograms. The highlighted areas show an aggregation on the RHS in the 38 and 120 
kHz echograms and an aggregation on the LHS on the 120 kHz echogram. 

The data depicted in Figure 45 will be used to demonstrate dB differencing techniques. It 
is visually obvious that the shallow aggregation has a stronger frequency response at 120 
kHz. You would also be able to see this behavior using the Frequency response graph 
(View menu, Graph Frequency response). The data was recorded outside Wineglass bay in 
Tasmania – fish that live in the region include Barracuda, Striped trumpeter, Australian 
salmon and Bream. 
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Figure 46. dB difference technique- the Echoview chain of virtual variable 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\5 Multiple frequency 
data\Bluefin school 2 frequencies.EV 
Click Open. 

3. Display both Sv echograms 

Calibration 

4. The calibration for the EK60 data is from the first ping. Transducer 1 is named 38 
kHz and Transducer 2 is 120 kHz. 

Surface line 

5. The EV file has an editable Surface line. It was first created at a fixed depth of 5m. 
This value is slightly larger than Rb but not 2Rb because the seabed is 20-35m deep 
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and 2Rb will exclude some of the LHS aggregation. Note the bands in the 38 kHz 
echogram in the first 5m are transducer ringdown. The Surface line has been edited 
to exclude an aggregation at the surface. 

Acoustic bottom line 

6. An editable line has been created using a Best bottom line pick. The Acoustic 
bottom line has been edited to skirt around seabed echo fixing areas where the line 
pick failed (at the RHS aggregation near the seabed). Note there are scatterers on the 
seabed. 
 
Exclude above line and Exclude below line have been selected on the Analysis page 
of the Variable Properties for Sv variables  

Regions 

7. It is possible to apply schools detection on the RHS aggregation –its mean Sv is 
about -48 dB. However the mean Sv for the LHS aggregation is about -77 dB. 

Noise 

8. Ping graphs show that wanted echoes are above the noise and TVG noise is not 
evident at the depths we are interested in. No noise strategy is applied for this 
exercise. 

Sv analysis – dB differencing 

9. Click the Variables and Geometry tool  
Click the View 1 page 

Process data 

Applies exclusions from the raw variable and changes excluded data points to ‘no data’. 

10. On the Shortcut menu select New, Variable. 
Name: 38 kHz cleaned 
Operator: Processed data 
Click OK 
Click the Operands page 
Operand1: 38 kHz raw 
Click the Calibration page 
Under Inherit calibration settings from: select No inheritance. 
Click OK. 

11. On the Shortcut menu select New, Variable. 
Name: 120 kHz cleaned 
Operator: Processed data 
Click OK 
Click the Operands page 
Operand1: 120 kHz raw 
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Click the Calibration page 
Under Inherit calibration settings from: select No inheritance. 
Click OK. 

Resample data 

12. On the Shortcut menu select New, Variable. 
Name: 38 kHz resampled  
Operator: Resample by number of pings 
Click OK 
Click the Operands page 
Operand1: 38 kHz cleaned 
Click the Calibration page 
Under Inherit calibration settings from: select No inheritance. 
Click the Resample page 
Under Input 
Ping selection: All pings in interval 
Number of pings in interval: 4 
Under Operation 
Resampling operation: Mean 
Select Weighting/Interpolation range 
Under Output 
Select Custom Ranges 
Start range: 0 
Stop range:35 
Number of datapoints: 35 
Click the Calibration page 
Under Inherit calibration settings from: select No inheritance. 
Click OK 

13. On the Shortcut menu select New, Variable. 
Name: 120 kHz resampled  
Operator: Resample by # pings 
Click OK 
Click the Operands page 
Operand1: 120 kHz cleaned 
Click the Calibration page 
Under Inherit calibration settings from: select No inheritance. 
Click the Resample page 
Under Input 
Ping selection: All pings in interval 
Number of pings in interval: 4 
Under Operation 
Resampling operation: Mean 
Select Weighting/Interpolation range 
Under Output 
Select Custom Ranges 
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Start range: 0 
Stop range:35 
Number of datapoints: 35 
Click the Calibration page 
Under Inherit calibration settings from: select No inheritance. 
Click OK 

dB difference 

14. On the Shortcut menu select New, Variable. 
Name: dB difference (120-38)  
Operator: Minus 
Click OK 
Click the Operands page  
Operand1: 120 kHz resampled 
Operand2: 38 kHz resampled 
Click the Calibration page 
Under Inherit calibration settings from: select No inheritance.  
Click OK. 

Range mask 

15. On the Shortcut menu select New, Variable. 
Name: Range Mask for LHS aggregation 
Operator: Data range bitmap 
Click OK 
On the Operands page 
Operand1: dB difference (120-38) 
On the Data range bitmap page 
Minimum in-range value: 3 
Maximum in-range value: 25 
Click OK. 
 
The in-range values were optimized by visual inspection of the Range mask 
echogram and later on with the final echogram for the LHS. You want to isolate the 
LHS aggregation. 

16. On the Shortcut menu select New, Variable. 
Name: Range Mask for RHS aggregation 
Operator: Data range bitmap 
Click OK 
On the Operands page 
Operand1: dB difference (120-38) 
On the Data range bitmap page 
Minimum in-range value: -20 
Maximum in-range value: 0 
Click OK. 
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The in-range values were optimized by visual inspection of the Range mask 
echogram and later on with the final echogram for the RHS. You want to isolate the 
RHS aggregation. 

Classification by dB difference 

17. On the Shortcut menu select New, Variable. 
Name: 120 kHz classified by dB difference with mask for LHS  
Operator: Mask 
Click OK 
On the Operands page 
Operand1: 120 kHz resampled 
Operand2: Range Mask for LHS aggregation 
Click OK. 

18. On the Shortcut menu select New, Variable. 
Name: 120 kHz classified by dB difference with mask for RHS  
Operator: Mask 
Click OK 
On the Operands page 
Operand1: 120 kHz resampled 
Operand2: Range Mask for RHS aggregation 
Click OK. 

Return to ping geometry of raw variable 

This step approximates the ping geometry of the 120 kHz raw variable – to facilitate visual 
comparison for the dB difference results. 

19. On the Shortcut menu select New, Variable. 
Name: Resample vertically LHS  
Operator: Resample by number of pings 
Click OK 
Click the Operands page 
Operand1: 120 kHz classified by dB difference with mask for LHS  
Click the Resample page 
Under Input 
Ping selection: All pings in interval 
Number of pings in interval: 1 
Under Operation 
Resampling operation: Mean 
Select Weighting/Interpolation range 
Under Output 
Select Custom Ranges 
Start range: 0.10 
Stop range:249.89 
Number of datapoints: 1301 
Click OK. 
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20. On the Shortcut menu select New, Variable. 
Name: Resample vertically RHS  
Operator: Resample by number of pings 
Click OK 
Click the Operands page 
Operand1: 120 kHz classified by dB difference with mask for RHS  
Click the Resample page 
Under Input 
Ping selection: All pings in interval 
Number of pings in interval: 1 
Under Operation 
Resampling operation: Mean 
Select Weighting/Interpolation range 
Under Output 
Select Custom Ranges 
Start range: 0.10 
Stop range:249.89 
Number of datapoints: 1301 
Click OK. 

21. On the Shortcut menu select New, Variable. 
Name: Match ping times LHS  
Operator: Match ping times 
Click OK 
Click the Operands page 
Operand1: Resample vertically LHS  
Operand 2: 120 kHz raw 
On the Match Ping Times page 
Allowed (slop): 600 
Click OK. 

22. On the Shortcut menu select New, Variable. 
Name: Match ping times RHS  
Operator: Match ping times 
Click OK 
Click the Operands page 
Operand1: Resample vertically RHS  
Operand 2: 120 kHz raw 
On the Match Ping Times page 
Allowed (slop): 600 
Click OK. 

23. Save EV file under another name. 

24. Close Echoview. 
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Figure 47. dB difference echograms and the 120 kHz raw variable from the worked example 

 
 Tips and tricks 

Refer to the Echoview Help file for more information regarding: 

 Operators 

 Virtual variables 

 The Variables and Geometry window 

 

Topic completed 

You can now: 

 Assess whether your data is suitable for frequency differencing analysis. 

 Apply a dB differencing technique with Echoview virtual variables. 
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6. Exporting data and further calculations 
What is covered? 

The Exporting data topic covers the export of analyses and calculations for areal density and 
fish flux. A discussion about the estimation of biomass is also included. 

The following steps in the Great Lakes Summary of the SOP are covered:. 

1. Export integration and TS data (10.5). 

2. Check for bias in situ TS (11.2). 

3. Calculate fish density (11.3 and 11.4). 

4. Apportion the acoustic fish density to different fish species (11.5). 

5. Make assumptions about fish in surface and bottom zones (11.5). 

6. Calculate fish density by species (11.4 and 11.5). 

7. Calculate uncertainty (11.6). 

 

 

Export integration and TS data 

 
Great Lakes SOP Summary 

13. Export integration and TS data (10.5). 

 

Exporting analyses from Echoview 

 
You can export data and analysis results from Echoview to use in further calculations and 
more complex analyses. 

Analysis export 

The export of analyses is available from the Echogram and Scene menus and includes: 

 Analysis by Regions 

 Analysis by Cells 

 Analysis by Regions by Cells 

The exports and analysis variables available will depend on the Echoview modules that are 
licensed and the type of echogram you are exporting from. 

Data from analyses can be exported in Database and Spreadsheet formats. Such exports are 
distinct from exporting data (i.e. the export of sample values). 

The Export page of the EV File Properties dialog box is used to select the variables and 
format of export files generated by the Export menu commands. 
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Export type Available 
from 

Analysis by 
Regions 

Analysis by 
Cells 

Analysis by 
Regions by Cells 

Integration  Sv echograms Integration by 
Regions 
(echogram) 

Integration by 
Cells 

Integration by 
Regions by Cells 

Single targets 
analyses 

Single target 
echograms 

Single target 
analysis by 
regions 

Single target 
analysis by 
cells 

Single target 
analysis by regions 
by cells 

Single targets 
frequency 
distribution 

Single target 
echograms 

Frequency 
distribution of 
single targets 
by regions 

Frequency 
distribution of 
single targets 
by cells 

Frequency 
distribution of 
single targets by 
regions by cells 

Fish Tracks 
analyses 

Single target 
echograms 

Fish track 
analysis by 
regions 

Fish track 
analysis by 
cells 

N/A 

Table 1: Table of Echoview integration and TS export analyses. 

 

 
Data export 

Data values from files read by Echoview and data values generated by Echoview can also be 
exported. This is distinct from the export of analysis results from Echoview.  

Data that are available for export include: 

 Data (and underlying data) values 

 Single targets 

 Target lengths  

 TS Frequency distribution 

 Lines 

 Region definitions 
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Exporting integration data – the Analysis region classes.EV 
example 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Analysis region 
classes.EV 
Click Open 

3. Display the Sv echogram. 

Configure the export 

4. Click EV File Properties  
Click the Export page 
Under Export these analysis variables: 
Clear all Analysis variable groups. 
 
Under the Analysis common group 
Select 
Num_layers 
Num_intervals 
 
Under the Analysis doamian group 
Select 
Height_mean 
Depth_mean 
Layer_depth_min 
Layer_depth_max 
Thickness_mean 
 
Under the Analysis export group 
Select 
EV_filename 
 
Under the Integration results group 
Select 
Sv_mean 
NASC 
PRC_NASC 
 
Under Analysis by cells 
Select Spreadsheet format 
Click OK 



6. Exporting data and further calculations        72 

 72

Export integration analyses (sv mean, NASC) 

Export an Integration by Cells 
5. On the Echogram menu select Export, Analysis by Cells, Integration 

6. Browse to a folder to put the export file into 
File name: NASC Cells 
Click Save 

Export an Integration by Regions by Cells 
7. On the Echogram menu select Export, Analysis by Regions by Cells, Integration 

8. Export regions with class: All classes 
Click Export 
Browse to a folder to put the export file into 
File name: NASC Regions by Cells 
Click Save 

9. In your export folder, threshold be two files: 
NASC Cells.csv 
NASC Regions by Cells.csv 

10. Close the EV file.  

 

Exporting TS data – the Fish tracking.EV example 
Single targets analysis  

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Fish tracking 
(Solution).EV 
Click Open. 

Configure the exports 
See also Configure the export. 

3. Click EV File Properties . 
Click the Export page 
Under Export these analysis variables: 
Inspect all the analysis variable groups and note which variables have been selected. 
Click OK 

Export integration analyses (sv mean, NASC, PRC_NASC) 
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4. Display the Sv echogram. 

Integration by Cells 

5. On the Echogram menu select Export, Analysis by Cells, Integration 

6. Browse to a folder to put the export file into 
File name: Fish tracking NASC Cells 
Click Save 

Integration by Regions by Cells 

7. On the Echogram menu select Export, Analysis by Regions by Cells, Integration 

8. Export regions with class: All classes 
Click Export 
Browse to a folder to put the export file into 
File name: Fish tracking NASC Regions by Cells 
Click Save 

Export Single targets analyses (mean TS) 

Cells by Single targets 

9. Display the Single target detection echogram. 

10. On the Echogram menu select Export, Analysis by Cells, Single Targets 

11. Browse to a folder to put the export file into 
File name: Fish tracking by cells by single targets 
Click Save 

Regions by Cells by Single targets 

12. On the Echogram menu select Export, Analysis by Regions by Cells, Single targets 

13. Export regions with class: All classes 
Click Export 
Browse to a folder to put the export file into 
File name: Fish tracking by regions by cells by single targets 
Click Save 

Export (TS) Frequency distribution analyses 
14. On the On the Echogram menu select Export, Analysis by Cells, Frequency 

Distribution. 

15. Browse to a folder to put the export file into 
File name: Fish tracking by cells by frequency distribution 
Click Save 

16. On the Echogram menu select Export, Analysis by Regions by Cells, Frequency 
Distribution 

17. Export regions with class: All classes 
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Click Export 
Browse to a folder to put the export file into 
File name: Fish tracking by regions by cells by frequency distribution 
Click Save 

18. Close the EV file. 

 

Fish track analyses 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Fish tracking 
(Solution).EV 
Click Open. 

3. Display the Single target detection echogram. 

Configure the exports 
See also Configure the export. 

4. Click EV File Properties . 
Click the Export page 
Under Export these analysis variables: 
Inspect all the analysis variable groups and note which variables have been selected. 
Select Direction_horizontal (useful for determining if the fish is going upstream or 
downstream). 
Click OK 

Export Fish track analyses 

Fish tracks 

5. On the On the Echogram menu select Export, Analysis by Regions, Fish tracks. 

6. Export regions with class: All classes 
Click Export 
Browse to a folder to put the export file into 
File name: Fish tracking by regions by fish tracks 
Click Save 

Single targets in fish tracks 

Configure the export 

7. .Click EV File Properties  
Click the Export page 
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Under Analysis by Cells, select Database Format 
Click OK 

8. On the On the Echogram menu select Export, Analysis by Cells, Fish tracks. 

9. Export regions with class: All classes 
Click Export 
Browse to a folder to put the export file into 
File name: Fish tracking by cells by fish track 
Click Save 
 
Note: Five export files are created. There is one line per target/fish track 
combination, and one column per analysis variable. This provides access to the 
single target data associated with each fish track. Because any one target can be 
included in more than one track, it may appear more than once in a file, once for 
each fish track it belongs to. 

10. Close the EV file. 

 

Check for bias of in situ TS 

 
Great Lakes SOP Summary 

14. Check for bias of in situ TS (11.2) 

“Check for quality of in situ TS measures for each analysis cell using the Nv index. Use the 
average �bs by depth region to calculate the Nv index. This is used to test if in situ TS can be 
used for density estimates. If Nv is > 0.1, replace the average �bs in that cell with average �bs

in surrounding cells or from the appropriate depth layer.” 

For more detailed discussion of this step refer to Great Lakes SOP Chapter 11. Survey 
Calculations section 11.2 

 

Calculate fish density 

 
Great Lakes SOP Summary 

15. Calculate fish density (11.3 and 11.4). 

“Calculate fish density by dividing ABC with mean �bs for each analysis cell. A density per 
unit area is obtained by summing over all layers in each bin. Fish•ha-1 is obtained from 
fish•m-2 by multiplying by 10,000. Be careful if using NASC to include the 4� term (Table 
1).” 
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Apportion acoustic fish density to different fish species 

 
Great Lakes SOP Summary 

16. Apportion the acoustic fish density to different fish species (11.5). 

“This is a critical step that should rely on current and previous experience from the lake, 
temperature profiles, and catch data.…” 

 

Make assumptions about fish in the surface and bottom exclusion 
zones. 

 
Great Lakes SOP Summary 

17. Make assumptions about fish in surface and bottom zones (11.5). 

“Decide how to deal with fish present in the surface and bottom exclusion zones (4.9). The 
report should be specific on what assumptions are made for these acoustic dead zones and if 
the choice was to exclude these areas from analysis.” 

 

Calculate fish density by species 

 
Great Lakes SOP Summary 

18. Calculate fish density by species (11.4 and 11.5). Calculate average fish density by 
species with the appropriate statistics for the survey design used. 
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Density calculations in a spreadsheet – the Analysis region classes.EV example 

Areal density of species 
1. In a spreadsheet program open NASC Regions by Cells.csv. 

2. With the following data and equation calculate the areal density each region 
contributes to interval number 5 and complete the table. 
 
NASC and PRC_NASC are briefly discussed in Regions – types and classes and are 
highlighted as topics of further interest at the end of the Scrutinization section. 
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Shallow -60 dB 0.5 kg  

500m -40 dB 1 kg  

Deep -80 dB 0.001 kg   

Table 2: Areal density by region. 

Apportion backscatter to different species 
This is a more complicated scenario in which it is assumed each region class is not 
populated with one species (or type) of scatterer but a mix. 

3. With the following data and equation calculate the biomass each species contributes 
to interval number 5 and complete the table. 
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schoolers 

10 -60 
dB 

0.5 kg  Shallow 

Plankton 90 -80 
dB 

0.001 
kg 

 

 

Large 
schoolers 

5 -40 
dB 

1 kg  500m 

Plankton 95 -80 
dB 

0.001 
kg 

 

 

Deep Plankton 100 -80 
dB 

0.001 
kg 

  

 

Table 3: Areal density by species mix. 

4. Calculate the total contribution of each species to interval number 5. Complete the 
following table: 

Species Areal Biomass Density 
 of that species in 

Interval 5 

(tonnes/n.mi2) 

Plankton   

Small schoolers  

Large schoolers  

Table 4: Areal density for interval 5. 

5. You have just completed the steps of a rudimentary density estimate using Echoview 
exports. The PRC_NASC for defined regions was combined with estimated species 
distribution within those regions to arrive at an estimate of tonnage each species 
contributed to the measured signal. 
 
A file with worked calculations for this section is located at: 
C:\Myriax\Echoview\Echoview4\Echoview manual\6 Export and further 
calculations\Density calculations (Solution).xls 
 
In the following exercise, you will find how Echoview provides more convenient 
features and export variables to automate much of this process and how it allows for 
a detailed mix of species. 
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Density exported from Echoview – the Analysis region classes.EV example 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\6 Export and further 
calculations\Integration export (Solution).EV 
Click Open 

Define the species composition of each class 
3. Click the EV File properties tool. 

Click the Regions page 
 
In the Species section click New 
Name: Small Schoolers 
Expected mean TS (dB): -60 
Expected mean weight (kg): 0.5 
Click OK  
 
Repeat with: 
Name: Large Schoolers 
Expected mean TS (dB): -40 
Expected mean weight (kg): 1 
 
And again with: 
Name: Plankton 
Expected mean TS (dB): -80 
Expected mean weight (kg): 0.001 

4. Under the Region Classes section 
Select Shallow 
Click Properties 
Click the Species Allocation page 
Double-click the Small Schoolers row 
Proportion of fish of this species for region class: 10 
Click OK 
 
Double-click the Plankton row 
Proportion of fish of this species for region class: 90 
Click OK 
 
Repeat for Region Class = 500m 
% Large Schoolers: 5 
% Plankton: 95 
 
Repeat for Region Class = Deep 
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% Plankton: 100 

5. Click the Export page 
Select these new variables from the Biomass group: 
Density_number 
Density_weight 
Select Spreadsheet format (single file) 
Click OK. 

Export integration analyses 
6. On the Echogram menu select Export > Analysis by Regions > Integration  

Export regions with class: All classes 
Click Export 
File name: Biomass Regions 
Click Save 
 
Note: Biomass analysis variables are calculated and exported for each valid 
region/species combination in this export. 

7. On the Echogram menu select Export > Analysis by Cells > Integration 
File name: Biomass Cells 
Click Save 

8. On the Echogram menu select Export > Analysis by Regions by Cells > 
Integration 
Export regions with class: All classes 
Click Export 
File name: Biomass Regions by Cells 
Click Save 
 
Note: Biomass analysis variables are calculated and exported for each valid 
region/cell/species combination in this export 

9. You should have three more files now: 
Biomass Regions.csv 
Biomass Cells.csv 
Biomass Regions by Cells.csv 

Examine the exported data 
10. Using a spreadsheet program open each of the three data files just created and 

examine their contents. You will see that Echoview has included species in the 
breakdown of data. 

11. Open the file: 
C:\Myriax\Echoview\Echoview4\Echoview manual\6 Export and further 
calculations\Complex density estimates (Solution).xls 
 
The calculations in this spreadsheet present the values exported from Echoview 
alongside our calculations. 
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The columns headed Density_number and Density_weight contain data exported 
from Echoview. The columns headed My Excel Density_number and My Excel 
Density_weight reproduce in Excel the Echoview calculations. 
 
The yellow section labeled Compare these with results from 
C:\Myriax\Echoview\Echoview4\Echoview manual\6 Export and further 
calculations\Density calculations (Solution).xls reproduces the calculations for 
interval 5 from C:\Myriax\Echoview\Echoview4\Echoview manual\6 Export and 
further calculations\Density calculations (Solution).xls. 

 

Biomass calculations – going from areal density to mass 

 

 

Figure 48. Fig 9.1 from Chapter 9 Data Analysis - Simmonds and MacLennan1 “Flow diagram showing the basic data and 
analysis procedures for obtaining fish abundance estimates from acoustic and biological data 

Figure 48 is taken from Simmonds and MacLennan Chapter 9 Data Analysis. The flow 
diagram and discussion of “Abundance estimation” in sections 9.5 to 9.8 provide a guide to 
calculating biomass. Sections 11.4 and 11.5 of the Great Lakes SOP discuss this as well. 
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Fish track analysis 

 
Exported fish track data can be opened in a spreadsheet for further post-processing. Topic 8 
of the Echoview tutorial Introduction to DIDSON data processing presents a detailed 
treatment of fish track analysis using Microsoft Excel.  

The topic is reproduced in Appendix I: Introduction to DIDSON data processing. Topic 8
Calculations and graphs. The complete tutorial can be obtained from the Echoview website. 

Fish track detection, using fish tracks and region classes is useful in the empirical study of 
fish detection sensitivity. 

 

Calculate uncertainty 

 
Great Lakes SOP Summary 

“19. Calculate uncertainty (11.6). Calculate uncertainty of the estimate including all aspects 
of uncertainty that is known at the time. List the sources of uncertainty included in these 
calculations.” 

 

Final checks 

 
Great Lakes SOP Summary 

“We also recommend as a final check of the data: 

1. Check to make sure all intervals are represented, unless the interval is excluded due 
to bad data classification. 

2. Sort segments and/or layers to see if any unreasonable fish densities are found. Refer 
back to echogram to see if the segments with the highest fish densities match up with 
dense fish areas on the echograms.” 

 

Reports – inclusion of standard information 

 
Great Lakes SOP Summary 

“Reports presenting fish density derived from acoustic data should include the following 
information: 

1. Hardware and software used, including version. 

2. Ping rates, pulse duration, field calibration information, beam width. 

3. Single echo detection parameters. 

4. The minimum threshold level that is considered to represent the fish of interest and 
the method used for noise removal. 
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5. The noise level at 1 m (Sv domain preferred) and the detection limit (range) for the 
smallest fish of interest. 

6. Information on the number of analysis cells with high Nv values. 

7. A graph of representative TS distributions for layers with differences in this 
distribution. Alternatively, provide a graph of TS versus depth. 

8. Information on decision rules for allocation of fish density to different species. 

9. Average fish density and method used for calculations (geostatistics, cluster 
sampling, etc.). 

10. Estimates of uncertainty, acknowledge which factors were included in the estimates. 

11. Map of the spatial distribution of fish density along transects to visualize spatial 
patterns and variability.” 

 

 
 Tips and tricks 

Refer to the Echoview Help file for more information regarding: 

 Exporting in Echoview 

 About exporting analyses 

 About exporting data 

 

Topic completed 

You can now: 

 Configure export analysis variables. 

 Export analyses from Echoview. 

 Use exported analyses to calculate areal density for different species. 

 Understand the procedures to estimate and scientifically report biomass. 
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7. Advanced visualization 
What is covered? 

This topic covers advanced visualization in Echoview using scenes and 3D objects created 
from your data. Visualization and data fusion in Eonfusion is also discussed. 

 

Scenes in Echoview 

 
Figure 49. Scene showing 3D objects created from data collected in Lake Washington – bottom surface, fish and 

macrophytes. 

 

 
Echoview scenes offer advanced visualization of echogram data, where 3D objects can be 
created and displayed in 3D space with respect to time. 

3D objects that can be created from single beam echograms are: 

 A surface from a line – the 3D representation of a line (such as the bottom pick or 
the surface line). 

 Echogram curtains - the 3D representation of an echogram. 

 3D Single targets - 3D points that represent single targets. 

 3D Fish track – 3D points that represent single targets in a fish track. 
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Single beam echogram curtain, 3D single targets, 3D fish tracks 

 
Figure 50. Fish track (Solution).EV – Sv echogram with detected 

fish tracks and minimum TS threshold 

 
Figure 51. Cruise track for the echogram in Figure 50.  

 
Figure 52. Echoview scene (Northward view) displaying 3D objects created from the echogram in Figure 50. A surface created 

from the acoustic bottom line and 3D single targets, 3D fish tracks and an echogram curtain.  

 

Fish tracking (Solution).EV example 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\4 Analysis\Fish tracking 
(Solution).EV 
Click Open. 
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Create a surface from a line 

3. Display the Single target detection echogram. 

4. On the Echogram menu select Create 3D Object, Surface from Line. 
Surface name: Top 
Line: Surface line 
Click Create. 
Click OK 
 
Repeat step 4 
Surface name: Acoustic bottom surface 
Line: Acoustic bottom line 

Create 3D Single targets, 3D Fish tracks 

5. On the Echogram menu select Create 3D Object, Single Targets. 
Click OK. 

6. On the Echogram menu select Create 3D Object, Fish tracks 
Click OK. 

Create an echogram curtain. 

7. Display the Sv echogram. 

8. On the Echogram menu select Create 3D Object, Curtain 
Under Transparency 
Select Values below the color display minimum 
Select Bad Data 
Select Outside exclusion lines 
Click Create 
Click OK. 

Add 3D objects to a scene 

9. On the View menu select Scene, New Scene. 
On the General page of the Scene Properties dialog box: 
Vertical exaggeration: 4.0 
Color scheme: Seascape 
 
On the Objects page 
Select 3D Fish Track group1 
Select Acoustic bottom surface 
Select Echogram curtain1 
Select Top 
Click OK. 
 
Refer to Figure 52 for a screenshot of the scene. 
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Scene navigation and features 

10. Click Move. 
Click and drag the mouse left, right or up and down to move in the scene. 

11. Click Rotate. 
Double click at the center of the curtain –this sets the center of rotation. 
Click and drag the mouse left, right or up and down to rotate relative to the center of 
rotation in the scene. 

12. Use the mouse wheel to bring the 3D object closer to you. 

13. The Shortcut menu is context sensitive with respect to objects in the scene. It 
provides access to scene and object features. 

 
Figure 53. Scene Shortcut menu. 

14. The scene time slider and replay controls allow you to view objects in time. 

 
Figure 54. Scene with the time slider and scene replay controls (highlighted). 

15. Save your work to a different file name. 

16. Close the EV file. 
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Echogram curtains with an imported surface. 

 

Figure 55. Single beam echogram for the cruise track in Figure 56. Red dots mark fish echoes on a sea mount 

 

Figure 56. Cruise track for the single beam echogram in Figure 55. 

 

Figure 57. Echoview scene with an imported surface 
representing Tasmania. The red circle 
indicates the cruise track displayed in 
Figure 56. 

 

Figure 58. Zoom-in on the Westward view of the Echoview scene 
depicted in Figure 57. The green line is the cruise track, the 
sea mount is represented by a surface created from the 
acoustic bottom line and the grey features around the sea 
mount are the echogram curtain displaying regions of interest 
(fish echoes). 

 

Figure 59. (Left) Closer view of the fish in the regions of 
interest. 
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Advanced 3D visualization - regions of interest and imported surfaces. 

The Advanced visualization 2.EV file contains pre-created surfaces from lines – the 
acoustic bottom line surface traces out the shape of a hill. 

The survey was conducted over a single hill this is difficult to discern from the Sv 
echogram. 

You should also observe that regions have been created around areas of interest (schools) 
on each transect and that the echogram provides no real sense of the spatial distribution of 
these schools. 

On the Variables and Geometry window, virtual variables can be used to create an 
echogram that only contains data in the regions of interest. You will create a curtain 
containing only regions of interest and then import a surface. The surface covers the entire 
Tasmanian coastline and allows you to view the surveyed area in a wider geographical 
context. 

Screen shots of Advanced visualization 2.EV and Advanced visualization 2 (Solution).EV 
show the echogram data, cruise track and scene are show by Figures 54 to 58. 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\7 Advanced 
visualization\Advanced visualization 2.EV 
Click Open. 

Virtual variables to display the regions of interest 

 
Figure 60. Variable and Geometry window: virtual variable chain to display the regions of interest. 

3. Click the Variables and Geometry window 

4. Display an echogram of the Bitmap - Analysis Regions = True variable. 
 
Note: The Region Bitmap operator has been used to create a Boolean variable on 
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which the analysis regions are assigned a true value and all other data are assigned a 
false value. The settings and operands for the virtual variable can be viewed on 
Variable Properties. 

5. Display an echogram of the Mask - Sv Data in Analysis Regions variable. 
 
Note: The Mask operator has been used to create a Sv echogram in which the Sv 
values from operand 1 (the Sv variable) are displayed in areas corresponding to true 
values in operand 2 (the Boolean variable). That is, the echogram displays Sv values 
in the analysis regions and -999.0 for all other samples. 

Create a curtain containing only regions of interest 

6. On the Echogram menu select Create 3D object, Curtain. 
Name: Fish schools only curtain 
Select Values below the color display minimum (this will remove the white 
background from the echogram)  
Select Outside exclusion lines (this will remove data that is part of the regions but is 
below the bottom exclusion line) 
Click Create 
Click OK. 
 
Note: In practice it would be preferable to create a separate curtain for each area of 
interest, i.e. create a curtain from a vertical selection that encompasses each school. 
The resulting curtains will have a higher resolution than a curtain created from an 
entire echogram 

Add the curtain to a scene 

7. On the View menu select Scene, Scene1 

8. On the Shortcut menu select Scene Properties 
Click the Objects page 
Select Fish schools only curtain  
 
Click Properties (for the Fish schools only curtain) 
On the Display page, clear Outline curtain border  
Click OK 
Click Close 
 
Note:  The scene shows a clear spatial distribution of schools that is difficult to 
visualize from the single beam echogram. 

Import a surface 

The surface you will use is a low resolution version of a surface that was originally created 
by GEOSCIENCE AUSTRALIA (www.ga.gov.au). A low resolution surface is used 
because the original file is very large and may cause slow performance on machines with 
limited graphics processing power. The low resolution surface was created using 
Echoview's "resample" functionality and export functionality, i.e. the high resolution file 
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was imported into Echoview on a machine with powerful graphics processing capabilities 
and was resampled at a lower resolution, then exported as a .csv file.  

9. On the View menu select Scene Manager. 
Click the Objects page 
Click Import 
Select Tasmania (low res).csv 
Click Open 
 
Surface Name: Tasmania (low res) 
Maximum triangulation distance: 10000.00 
Click Import 

10. Display Scene1 

11. On the Shortcut menu select Scene Properties 
Click the Objects page 
Select Tasmania (low res) 
Click OK 

12. On the Shortcut menu select Map View. 
 
Note:  The cruise track of the survey area is visible on the north-east of Tasmania 
just off the edge of the continental shelf. 

13. Move in on the survey area and other areas of interest – use a combination of mouse 
wheel, Move and Rotate. 

14. Close the EV file without saving. 

Because Echoview has no limit on the number of filesets, you could take data from other 
surveys around the Tasmanian coast and add them to the same scene. This would allow 
you to navigate between survey areas and make geographic comparisons that would be 
very difficult to visualize using only two dimensional displays. 
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Visualization in Eonfusion 

 

Echoview echogram data can be exported 
to Eonfusion for advanced spatio-temporal 
visualization and analysis with other 
diverse data. 

Eonfusion is a unique new software 
product. It provides cutting-edge 
processing and visualization of time-
varying spatial data through an interface 
that is flexible, easy to use and intuitive.  

Eonfusion's use of true data fusion means 
that the data are genuinely integrated, 
yielding insight that you've never had 
before and results that you didn't know 
were possible. Explore our site to find out 
more at  
http://eonfusion.myriax.com/home. 

 
 

Figure 61. Two images from the Eonfusion image gallery: 
http://eonfusion.myriax.com/applications/image_gallery 
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Figure 62. These images (1,2,3,4 left to right and down) were generated from an Eonfusion scene that combines land 
shapes, bathymetry, transect definitions and an array of fish abundance estimates derived from echosounding. 
The fish abundance estimates were generated from data gathered during multiple surveys per year over the 
course of several years. Once the data are in the scene it's simply a matter of moving the time slider to see the 
changes in fish distribution within a given year and from year to year. 
 
The scale-independent nature of Eonfusion's data handling engine and scene view means that the original high-
resolution raw data can also be loaded into the scene and viewed with the spatially summarized plots. This 
provides an intuitive and dynamic environment within which outliers and anomalies can quickly and easy be 
investigated within the source data. 
 
Myriax gratefully acknowledge Chris Wilson and Paul Walline (NOAA-NMFS Alaska Fisheries Science Center) for 
providing these data. 

 Tips and tricks 

Refer to the Echoview Help file for more information regarding: 

 About scenes 

 Table of contents – Using Echoview > Working in 3D 

 

 

Topic completed 

You can now: 

 Create 3D objects from single beam echogram data. 

 Add 3D objects to scenes. 
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 Use scenes to display your data in three spatial dimensions and time. 
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8. Echoview templates and live viewing of 
data 
What is covered? 

In this topic you will learn how to create an EV file template or a live viewing template. 
Creating a new EV file based on a template allows you to automatically apply pre-configured 
processing steps when you add data to the new EV file. This saves time when you work with 
similar data. 

The second part of this topic discusses how to use Echoview to live view data. 

 

About templates 

 
New EV files can be based on a template. Templates provide a way to store and apply 
regularly used EV file settings and processing methodologies. 

New EV files based on a template are created with a one-time copy of all the settings stored 
in the template. When you add data, the stored settings are applied but can then be tailored 
to the data – the template itself is unaltered and can be used as a base for future new EV files 

Templates are normal EV files (stripped of references to echosounder data files) stored in a 
nominated template folder or live viewing template folder  

A table of the objects and settings that are copied from a template appears in the Echoview 
Help file on the About templates page. 

 

Creating a template 

The Scrutinization of data (Solution).EV file contains all the Echoview processing steps 
and settings required to prepare specific EK 60 data for analysis. If you have additional 
data recorded under the same conditions, then to a first approximation that EV file can be 
used with the additional data. In effect the Scrutinization of data (Solution).EV file can be 
used as a template. 

1. Start Echoview. 

2. On the File menu select Open. 
Browse to:  
C:\Myriax\Echoview\Echoview4\Echoview manual\3 Scrutinization\Scrutinization 
of data (Solution).EV 
Click Open. 

3. On the File menu select Configuration. 

4. Click the File locations page. 
In the Files types section click Templates. 
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Click Edit. 
Browse to:  
C:\Myriax\Echoview\Echoview4\Echoview manual\9 Templates 
Click OK 
Click OK 
On the File menu click Save As. 
Browse to: 
C:\Myriax\Echoview\Echoview4\Echoview manual\8 Templates 
Under File name type Scrutinization template 
Click Save. 

5. On the File menu click Close. 

6. A live viewing template folder and live viewing templates are created in a similar 
fashion. Use steps 3-4. 
In the File types section click Live viewing templates. 

 

Using a template 

When you create a new EV file, Echoview will offer you a list of available templates from 
the location specified for Templates. 

7.  On the File menu click New. 

8. Click Scrutinization template.EV 
Click OK 

9. Examine the new EV file: 
there are no data files in Fileset1 

10. Add the data file: 
C:\Myriax\Echoview\Echoview4\Echoview manual\1 View and inspect\L0014-
D20021004-T140000-EK60.raw 

11. Examine the Variable Properties settings and Variable and Geometry window. 

12. On the File menu click Close. 
- OR – 
Save your new EV file. 

13. Close Echoview 
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Live viewing of data 

 
Simrad ER60 software logs raw data from an Ex60 echosounder, but in order to get a real 
time display of that data in Echoview as it is being logged, you need to also run Echolog 60. 

The Live viewing module allows the near real-time display of data logged from some 
supported echosounders (currently Simrad Ex60, EK500, EA500, and SM2000 FR). 

When live viewing is started, Echoview automatically creates an EV file. It will use an 
appropriate live viewing template if one is available. 

Echograms, rectangular selections, schools detection, linked graphs, cruise tracks and scenes 
will respond to newly arrived data when live viewing. 

All (licensed) Echoview functionality is available during live viewing. This means you can, 
for example, run echo integrations, detect schools or fish tracks and create virtual variables 
on live viewed data. Virtual echograms created in a live viewing EV file will also scroll and 
update automatically providing multiple-frequency and other analyses in real time. 

The Echoview website offers a Live viewing tutorial that demonstrates the use of the 
Echolog 500 logger. For further information refer to: 

http://www.echoview.com/Tutorials.shtm 

 

Echolog module 

 
The Echolog programs are free but must be licensed for use. 

The Echolog 60 module enables the live viewing and/or data compression of .raw data from 
Simrad Ex60 echosounders. 

Features include: 

 Echolog 60 for live viewing, logging and/or data compression of Ex60 echosounder 
data.  

 Echozip 60 for data compression of data files logged by Ex60 echosounders  

 Echodepth for displaying sounder-detected depths during logging.  

 Echosim 60 for simulating an EK60 for testing and set-up purposes.  

For more information about other Echolog modules refer to the Echoview website: 
http://www.echoview.com/AboutEchoview.shtm#Detail 

 

Basic logging and live viewing  

This example uses Echosim 60 and Echolog 60 to simulate live viewing. 

Echosim 60 simulates a Simrad EK60 that is logging raw data – raw data comes from the 
Ex60 raw data folder and is written to the EK60 Survey folder. 
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Echolog 60 broadcasts raw data from Simrad Ex60 echosounders as it is being written by 
the ER60 or EK60 software – data is read from the Survey folder and is broadcast. 

 
Figure 63. Right – Echolog 60 window. Left – Echosim 60 window.  

 
Figure 64. Bottom – Live Viewing dialog box with one Echolog 60 logger broadcasting. 

Top – Echogram of the Sv T1 variable updating as data is broadcast from Echolog 60. 

Launch Echolog 60 

The Echolog 60 window is a display only window, which tells you when data is being 
logged and other information 

1. On the Windows Start menu 
Select All Programs, Echoview, Echolog 60 

2. If the EK60 Survey folder doesn’t exist, the Settings dialog box opens automatically, 
and requests that you to specify a folder to log data to.  
 
Click Browse (to the left of the EK60 survey folder box) 
Browse to 
C:\Myriax\Echoview\Echoview4\Echoview manual\8 Logging and Live Viewing 
Click Make a new folder 
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Folder name:EK60 Survey folder. 
Click Close (Settings window) 

Configure Echolog 60 

3. Right-click on the Echolog 60 title bar, and select Settings. 

4. Browse to select an EK60 survey folder 
C:\Myriax\Echoview\Echoview4\Echoview manual\8 Logging and Live 
Viewing\EK60 Survey folder 

5. Leave the remaining six settings at their default value  

6. Clear Data compression 

7. Click OK 

Other Echolog features 

8. Right-click the Echolog 60 title bar, and select Network Information. 
Click OK. 
 
This is a simple way to determine your IP address and how much logging space you 
have available. 

9. Right-click the Echolog 60 title bar, and select Reset Statistics 
This command will reset all counters to zero 

10. Leave Echolog 60 running 
Echolog 60 is now ready for operation, and will broadcast any data that is written 
into the survey folder. All instances of Echoview running on the network will be 
able to display the broadcast data in real time. 
 
For testing or exercise purposes use Echosim 60 to simulate the Ex60 sounder. 
Echosim takes an existing data file and writes to the survey folder in the same way 
as the Ex60. 

Start Echosim 60 

11. On the Windows Start menu 
Select All Programs, Echoview, Echosim 60 

12. Under Read from folder browse to select 
C:\Myriax\Echoview\Echoview4\Echoview manual\8 Logging and Live 
Viewing\EK60 raw data 

13. Under Survey folder browse to select 
C:\Myriax\Echoview\Echoview4\Echoview manual\8 Logging and Live 
Viewing\EK60 Survey folder 
 
Note:  This is the directory to which Echosim will write data and must be the same 
folder from which Echolog 60 reads data (see EK60 survey folder setting). 

14. Set Delay (ms) to 200 
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Note:  This specifies the time between the writing of 2 consecutive pings to the 
survey folder. 

15. Click Start  

16. Click Show details 
You should see the Bytes written value growing, and the progress bar advancing as 
Echosim writes data. After a slight delay, you should see the Bytes read value on the 
Echolog 60 window increasing. Echolog 60 is now broadcasting the data it reads 
from the survey folder. 
 
Tip:  You can also view the changes in files using Windows Explorer. You will 
need to display the survey folder and press the F5 key to refresh the file details. 
 
Note: Data is logged to the survey folder (by Echosim or an Ex60 sounder) 
regardless of whether Echolog 60 is running. Echolog 60 is only required to enable 
live viewing of the data in Echoview, or compress the EK60 raw data files in real 
time. 

Live viewing 

17. Start Echoview  

Click Live viewing . 
The Live viewing dialog box displays detected Echolog applications. 

18. Select the Echolog 60 logger you have running by double clicking its entry  
 
Note: Echolog applications are named by default as the name of the computer 
running Echolog. This name is displayed in the Live viewing dialog box. Double 
clicking an entry displays the Live viewing variables dialog box, which lists 
variables available for live viewing. 

19. Select the first variable in the list EK60/ES60 Sv raw pings T1 
Click OK 
 
Note: Echoview will display an echogram which is updated automatically as data is 
broadcast by Echolog 60. 

Using Echoview during live viewing 

Most functions in Echoview are available during live viewing. Many update automatically 
during live viewing e.g. echograms, advancing and extending rectangular selections on 
echograms, schools detection, linked graphs and scenes 

20. Zoom in to an area on the right hand edge of the visible data 
Wait a moment; Echoview will scroll automatically as data arrives 

21. Zoom out 

22. Zoom in to an area on the left  
Wait a moment: Echoview will maintain the current view, but you will see the 
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horizontal scroll bar move and resize as data arrives 

23. Open the Filesets window, and from there open the echograms of the other 
variables. 
Minimize the Filesets window. 
Tile horizontally 
 
Tip: Scroll all echograms to the far right to see them update in real time. 

Selection movement during Live Viewing 

You can choose the way in which rectangular selections move during live viewing. 
Selections can remain stationary, advance with new data, or extend as new data is 
received. Graphs that are linked to selections will update with advancing or extending 
selections as new data is received. 

24. Make a rectangular selection on the Sv echogram 
Use the Rectangle tool or the Vertical band tool 
On the Echogram menu, select Selection Movement, Extending. 
 
Wait a moment until new data arrives and notice that the left boundary remains 
stationary in time while the right boundary extends relative to the last live viewing 
ping. 

25. Make another rectangular selection on a Sv echogram 
On the Echogram menu, select Selection Movement, Advancing. 
 
Note: On the Selection Movement list, the currently selected movement appears with 
a bullet next to it. 
 
Wait a moment until new data arrives and notice that both the left and right 
boundaries of the selection move in time and the width of the selection remains the 
same. 

26. On the View menu, select Graph, Threshold response. 
Under Variable list, select Fileset1:Sv raw pings T1  
Click OK 

27. On the Graph menu, select Linking, Selection 
As new data arrives, the graph is updated accordingly. 

28. Close the EV file without saving. 

29. Close Echosim 60 and Echolog 60. 

 
 Tips and tricks 

Refer to the Echoview help file for more information regarding: 
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 About templates 

 About template folders 

 About live viewing 

 Using live viewing 

 

Topic completed 

You can: 

 Create and use EV file templates and live viewing EV file templates 

 Set up Echolog 60 to broadcast data for live viewing in Echoview. 

 Use live viewing features for selections. 
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Appendix A: Echoview® DVD installation 
guide 
Overview 

This installation guide explains how to install Echoview and associated software from the 
Echoview DVD. 

 

Note: The installation or use of the software on the Echoview DVD indicates acceptance 
of the license conditions. Please read the license agreement displayed during the 
installation process. 

Before you begin 

You must be logged in as an administrator or power user during installation. You must also 
run Echoview once under an administrator or power user account to ensure registry settings 
are correct. 

The successful operation of Echoview requires that certain Microsoft programs and operating 
system patches are present on your computer. The Echoview installation program checks for 
the required software updates and informs you if any need to be installed that are not found. 
Please consult Myriax if you need assistance installing a patch. 

Warning:  Echoview bases these checks on the English language version of the software. If 
you are using another version of the software you should refer to the Microsoft 
website or contact Echoview support (support@echoview.com) before installing 
any recommended updates. 

Consult Echoview Help for minimum and recommended hardware requirements. 

During the installation process you will be asked to choose the folders in which to install 
Echoview and other files. You should use the default settings unless you have a valid reason 
not to do so. 

Note: Installation of a major release will by default create a new Echoview folder, i.e. 
C:\Program files\Myriax\Echoview\Echoview4. Installing a minor release (or revision) will 
overwrite the previous minor release of Echoview. If you wish to keep a previous release of 
Echoview, we recommend you rename the Echoview folder or move the folder before 
running the installation. 
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Installing Echoview from DVD 

Displaying the installation menu 

Insert the Echoview DVD into the DVD drive of your computer. The Echoview installation 
menu should be displayed. If it is not displayed, use Windows Explorer to browse to the root 
folder of the Echoview DVD then double-click Autorun.exe. 

 

Echoview installation menu 

 
Installing Echoview 

To install Echoview on your hard drive, click Install Echoview�and choose an installation 
option: 

• Typical. This is recommended if you use a Simrad Ex60 (EK60, EA60, EA400 and 
EQ60, ES60 and EY60) echosounder or Simrad Ex500 (EK500 and EA500) 
echosounder. In addition to files and programs included in the Compact installation, this 
installs the Echolog 500 and Echolog 60 modules and some example scripts for the 
scripting module. 

• Custom. This is recommended if you want to select which programs and files to install. 
All programs and files that are installed by the Compact and Typical installation options 
will be available for selection along with some additional options. You can also use this 
option if you have already installed Echoview and wish to install additional programs 
and files. You must use this option if you wish to install Echocheck and Echocalc GPS. 

• Compact. This is recommended if you use an echosounder that is not listed above. This 
option installs Echoview, Echoview Help, and some example data files.  
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Installing the HASP dongle driver 

The HASP dongle device driver is required if you are running a licensed copy of Echoview. 
During installation of Echoview a dialog will appear prompting you to install the driver. 
Click Yes if your copy of Echoview is licensed, or if you are using a time dongle (see the 
Dongle Installation Guide for further details). In all other cases click No. 

The driver can also be installed at a later date using the program provided in the Useful 
Items\Dongle Driver folder.  

Installing other programs 

To access other programs and files on the Echoview DVD click Browse DVD. Other 
programs that may be of use can be found in the Useful Items folder. Each folder contains a 
ReadMe file that provides further information and installation instructions.  

Installing the tutorials 

A number of tutorials are included on the Echoview DVD to help you learn how to use 
Echoview and explore some of its basic features. To install the tutorials click Browse DVD, 
open the Documentation\Tutorials folder, then double-click the tutorials you wish to install. 
The following tutorials are provided: 

• Getting started with Echoview (GettingStarted.exe) 

• Introduction to Integration (IntroToIntegration.exe) 

• Introduction to Fish Tracking (IntroToFishTracking.exe) 

• Introduction to Live Viewing (IntroToLiveViewing.exe) 

• Introduction to DIDSON data processing (IntroToDIDSONDataProcessing.exe) 

You will also need to double-click DataFiles.exe to install the tutorial data files. 

The tutorial handbooks are installed in the following folder: 
C:\Myriax\Echoview\Echoview4\Tutorials by default. They are provided as PDF documents 
and you will need to have Adobe Acrobat Reader installed on your computer to view them. If 
you do not have a copy of Adobe Acrobat Reader already installed you can install it from the 
Useful Items\Adobe Acrobat Reader folder on the Echoview DVD. 

Assistance 

For assistance with the installation of Echoview, please contact Echoview support: 

• email support@echoview.com,  

• phone +61 3 6231 5588 or fax +61 3 6234 1822. 
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For assistance using Echoview, do one or more of the following: 

• complete the relevant tutorial(s), 

• refer to the Echoview help file (this is the primary source of information about 
Echoview), or 

• contact Echoview support (support@echoview.com). 
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Appendix B: Unable to open Echoview’s 
Technical Manual data files in Echoview. 
Unable to open topic files in Echoview 

1. If you cannot find the files: 
The files for this manual’s topics are typically located in: 
C:\Myriax\Echoview\Echoview4\Echoview manual. 
 

 
 
The file path may be different if you chose to install the manual elsewhere on your 
system. If the files are not in this folder, use Windows Explorer to search for them. If 
they are not loaded on your machine, reinstall the manual and data files from the 
Echoview Technical manual DVD. See also Supplied data files. 

2. If you cannot open the files: 
You have a version of Echoview that is older that the version of Echoview this 
manual’s EV files were created with. Upgrade to Echoview 4.50 or higher. 
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Appendix C: Abstracts of hydroacoustic 
survey protocols and the Great Lakes 
Standard Operating Procedure (SOP) 
NOAA Protocols for Fisheries Acoustics Surveys and Related 
Sampling  
January 15, 2004. Prepared by: Members of NOAA Fisheries Science Centers, U.S. 
Department of Commerce, National Oceanic and Atmospheric Administration and National 
Marine Fisheries Service 

“Appendix 1: 

NOAA Protocols for Fisheries Acoustics Surveys and Related Sampling at the 
Northeast Fisheries Science Center 

Atlantic herring (Clupea harengus) spawning stock biomass in the Georges bank region. 
Biomass estimates are derived by scaling the abundance estimates by an empirical length-
weight relationship. Age-based estimates are derived from the age composition of the trawl 
catches.” 

 

“Appendix 2: 

NOAA Protocols for Fisheries Acoustics Surveys and Related Sampling at the 
Alaska Fisheries Science Center 

The Alaska Fisheries Science Center (AFSC) conducts acoustic-trawl surveys in the Bering 
Sea and Gulf of Alaska. The target species is walleye pollock (Theragra chalcogramma). 
Abundance–at-age estimates from these surveys, along with bottom trawl survey data and 
fishery catch data, are used to model population size, and, in turn, to establish quotas for the 
commercial fishing industry under the auspices of the North Pacific Fishery Management 
Council.” 

 

“Appendix 3: 

NWFSC Regional Protocols For the Joint Canadian and U.S. Pacific Hake 
Acoustic Survey 

Scientists from the United States (NOAA Fisheries) and Canada (Department of Fisheries and 
Oceans) jointly conduct periodic acoustic surveys of Pacific hake, Merluccius productus, along 
the west coasts of both countries. The age-specific estimates of total population abundance 
derived from the surveys are a key data source for the joint US-Canada Pacific hake stock 
assessments and ultimately act as the foundation for advice on international harvest levels.” 
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Standard Operating Procedures (SOP) for Acoustics in the Great 
Lakes  
Prepared for The Study Group on Fisheries Acoustics in the Great Lakes and the Great Lakes 
Fishery Commission. Version 1.0 Based on discussion in the Study Group 2002-2006.  

January 16, 2008. 

 “The goal of fisheries acoustic surveys in the Great Lakes is to provide estimates of species-
specific biomass and abundance of the primary forage fish (primarily alewife, rainbow smelt, and 
coregonids). Acoustic surveys are currently being conducted on all of the Great Lakes and some 
inland lakes, including Lake Champlain. Techniques and equipment reflect differences among the 
surveys with respect to target species and assessment goals as well as site-specific history of 
equipment…. The NMFS/NOAA acoustic SOP was provided to the Study Group for evaluation 
of its applicability to the Great Lakes. In the development of this Great Lakes SOP, we modified 
sections of the NMFS SOP when appropriate and, in cases where our SOP was unique, developed 
our own procedures.” 
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Appendix D: Examples of echogram 
interpretation 
The following screen shots of echograms displayed in BioSonics Visual Analyzer and the 
interpretations are included in this manual with the kind permission of Mr. James Dawson 
and Mr. Robert McClure of BioSonics. 

BioSonics, Inc. 
4027 Leary Way NW 
Seattle, WA 98107 
USA 
 
Web: www.biosonicsinc.com 

Note: Some echograms display data from a horizontally mounted transducer, these have an 
additional label - Horizontal mount. Where echograms do not have this label, the data is from 
a vertically mounted transducer. 

Intensity steps 

 
Figure 65. Intensity steps. These could be produced by reducing either receiving gain or transmit power, or by increasing 

threshold. 
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Time-series or Echogram of large target (high sensitivity) 
Horizontal mount. 

 
Figure 66. This image represents about 2.5 minutes. The image of the large target is seen as the yellowish pattern at far range. 

The horizontal streaks are produced by several types of targets. The short black line at close range is probably a small 
fish passing through the beam. The horizontal blue streaks are structures located on the bottom, such as rocks, 
pilings, and other fixed targets. Other horizontal streaks have a slight angle to them, such as the one starting at about 
20 m range and ending at about 22 m. These are moving targets, and are most likely neutrally buoyant targets kicked 
up from the bottom by the large target, and passively drifting through the beam. 
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Fish at maximum observational range 
Horizontal mount. 

 
Figure 67. A fish, at maximum range. It maintains a relatively constant distance from the transducer and then moves closer after 

ping #300 until it moves out of the acoustic beam. 
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Herring aggregations, bubbles, 2nd and 3rd echoes 

 
Figure 68. Herring aggregations (schools). Visible are second and third bottom echoes, also visible are the second echoes 

from schools. The low energy signals above the school to the left are bubbles released as the fish are migrating 
up in the water column. 

Transducer tilted – diving fish 

 
Figure 69. Transducer tilted, tow fin nose down, makes it appear as though the fish targets are ‘diving’. 
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Bubbles from sediment 

 
Figure 70. Bubble columns rising from the sediments, either methane or more likely hydrogen sulfide gas. 

System noise 

 
Figure 71. System noise – here is an example of electronic noise that has been amplified above the threshold level. This 

noise is not acoustic in nature. It would also be present in ambient mode and visible with echosounder in ‘passive 
mode’. Always a good idea to operate your system in passive mode when you have a new or changed installation 
to ensure that your system noise (from the echosounder or the environment) is minimal or absent. 
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Standard sphere calibration 

 
Figure 72. Standard sphere calibration with ‘helpers’ (fish attracted to the calibration sphere). 

Multi-path reflections from fish when the beam is grazing the 
boundaries. 
Horizontal mount. 

 
Figure 73. Multi-path reflections from fish when the beam is grazing the boundaries. Visible are both the direct echo 

from the fish and the later echoes which come from the acoustic beam being refracted off the surface or the 
bottom. 
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Side-lobe reflection from steep side of basin and tilted transducer 
mount 

 
Figure 74. Side-lobe reflection from steep side of basin. Tilted target traces indicate a tilted transducer mount. 

Standing Timber – trees on the bottom of a flooded river valley. 

 
Figure 75. Standing timber – trees on the bottom of a flooded river valley. 
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Mobile survey, horizontally aimed beam, Sacramento River. 
Horizontal mount. 

 
Figure 76. Surface reverberation, 10-35 m, strong reflections at 35+ m are far bank. Near range target is boat plus wake.  

Mobile survey, horizontally aimed beam, Sacramento River. 

Boat wakes. 
Horizontal mount. 

 
Figure 77. Boat wakes. Red signature is side of barge, horizontal aiming in the Illinois River. Note reflections both from bow 

wave and from entrained air. Note double or second echo from side of barge and tug. Note reduction in far side 
red echo. 
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Structure, targets heading in different directions 

 
Figure 78. Structure – beam hitting a fixed structure near the turbine intake on a dam. The horizontal band at approximately 

32m is the echo from a protruding structure on the side of the dam. Note “Long-to-Short” and “Short-to-Long” 
targets, indicating that targets are not all heading the same direction during detection. 

Wallowing fish 
Horizontal mount. 

 
Figure 79. Wallowers – fish spending a long time in the beam, moving closer then farther and then closer to the transducer. 
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Cross-talk 

 
Figure 80. Cross-talk from another echo sounder. 
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Appendix E: Working range for far-field 
conditions. 

Variable Definition 

a Transducer diameter (m) 

f Frequency (Hz) 

c 
Sound speed (m/s) 
c fλ=  

λ Wavelength (m) 

α Absorption coefficient (dB/m) 

Rb 

Near field range boundary23 (m) [Simmonds and MacLennan 
2005] 

λ
2a

Rb =  

And also, 

c
fa

Rb

2
=  

2Rb 

Range for far field conditions24 [Simmonds and MacLennan 
2005] 

c
fa

Rb

22
2 =  

(4)  

An example: 

Simrad 38-7 38k Hz Single beam EK60 transducer. 

a = 424mm = 0.424m 

f = 38kHz 

c = 1490 m/s 

2Rb = 9.2m 

Note: Non-ceramic transducers, which have poor physical damping can produce transducer 
ring noise that extends even beyond the 2Rb range. 
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Appendix F: EK60 output saved to the 
EK500 data format. 
Calibration settings or transducer draft are not recorded in a file when EK60 output is saved 
in the EK500 data format. However if your data is also saved in the EK60 data format, you 
can calibrate the EK500 Sv power variable by using the calibration values recorded with the 
EK60 data. You will also need to calculate Sv Gain and wavelength - EK500 Sv power 
calibration values. 

Use the Ex60 Power to Sv and TS calculation page in the Echoview help file. For the EK60 
the Transducer gain and Sa correction are in separate terms within the equation. To calculate 
Sv gain (on its own), the terms are brought together. 

Calculated Sv Gain* for .ek5 file = Transducer gain (EK60) + Sa correction (EK60) 

Calculated Wavelength (m) = speed/frequency 

 

Table 5: EK60 calibration values 
Calibration settings EK60 (from first ping) Sv 

calibration settings 
Transducer 1  
Transducer draft (m) 3.5 

Absorption coefficient (dB/m) 0.0098139 

Sound speed (m/s) 1465.00 

Transmitted power (W) 1000.0 

Two-way beam angle (dB re 1 Steradian) -15.50 

Transducer gain (dB) 21.9600 

Sa correction (dB) -0.68 

Transmitted pulse length (ms) 1.024 

Frequency (kHz) 38 

Calibration 2 page Check apply TVG range 
correction. Offset = 2 

Calculated Wavelength (m) = 
speed/frequency 0.03855263 

Calculated Sv Gain* for .ek5 file =  
Transducer gain + Sa correction 21.28 
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Appendix G: Hydroacoustic issues 
associated with acoustic bottom verification 
Acoustic beam dead zone  

Simmonds and MacLennan7 (2005) discuss the topic Integration near the seabed. They consider the 
‘dead zone’ for cases of the acoustic beam perpendicular to a horizontal seabed and to a seabed slope. 
They also discuss the traditional corrections and assumptions for fish in the dead zone and the impacts 
on estimates of abundance. 

An example of experimental dead zone measurements for a sloping seafloor is in the report by Kloser 
and Ryan et al25 (2001). The screenshot (below) displays their calculations. 

For a 38 kHz system25 where the pulse length is 3ms, they calculated a mean experimental dead zone 
height of 25m for a seafloor slope of 16 degrees. 

 

 
Figure 81. ‘Modelling the dead zone’ , Kloser and Ryan et al25 p78.  
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Signal from beam side lobes 

A slope in the seabed can produce signals from the side lobes of the beam under certain 
conditions. The report by Kloser and Ryan et al25 (2001) contains an example of identified 
side lobe interference  

 

 
Figure 82. An example of side lobe interference from Kloser and Ryan et al25 p88. 
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Appendix H: Using virtual variables in 
Echoview 
A powerful way to process echogram data is to use synthetic or virtual echograms*. In 
Echoview, a virtual variable (virtual echogram) is created by applying an operator (a 
mathematical algorithm) to one or more input acoustic variables (operands). Operands may 
be raw variables or other virtual variables. 

Operators may be chained to create additional virtual variables; that is, by using the output of 
one virtual variable as input to another. 

You view and manage virtual variables using the Variables and Geometry window . 

Variables and Geometry window 
You can view raw variables, lines, transducers and virtual variables in the Variables and 
Geometry window. Use Shortcut menu selections to create, delete and manage variables and 
geometry. 

 

Figure 83. Shortcut menu (right-click) in the Variables and Geometry window. 
Creation of a virtual variable. 

 

 

 

 

 

 

* Fisheries Acoustics 2nd Ed. (Simmonds and MacLennan, 2005), p334 
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Operators 

To create a new variable. 

 On the Shortcut menu 
select New, Variable. 

To create a new editable line. 

 On the Shortcut menu 
select New, Editable line. 

To create a new virtual line. 

 On the Shortcut menu 
select New, Virtual line. 

 

Then: 

Name and select an operator on the New variable 
dialog box.  

 

Figure 84. New Variable dialog box. Enter the virtual variable name 
and select an operator. 

Virtual variable properties 

Select input operands, operator settings and other settings on the pages of the Variable 
Properties dialog box for the virtual variable.  

 

Figure 85. A Multibeam target detection variable properties dialog box. 
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Virtual variable echogram 

To view a virtual echogram, double-click the virtual variable or select Echogram on the 
Shortcut menu. 

 

Figure 86. Multibeam target detection echogram. 
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From Virtual variables training exercises 
Exercise 10: Calculating Calibration Constants in Echoview 
In this exercise you will calculate and apply a TS calibration constant. This represents one of 
the key stages in calibrating echosounder data and ensures the TS values of logged data are 
accurate. We examine TS from raw power data logged by a Simrad EK60 echosounder using 
a -35.00 dB calibration sphere. The objective is to tune the TS calibration constant (TS gain) 
such that the TS of calibration sphere measurements is equal to the known value of -35.00 
dB. Echoview applies a default value but you must change this to properly calibrate your 
echosounder. 

 

The exercise will teach you how to use Echoview, rather than the theory of calibration 
techniques. Specific values used in this exercise are illustrative only and may not be 
recommended or applicable to your work. For further information about calibration 
techniques you are referred to the scientific literature. 

 

You will complete this exercise in the following stages: 

 

 Open the EV file (which contains the soundings taken from a calibration sphere) 

 Calibrate all variables (Calibration and Calibration 2 pages) and the transducer  

 Create exclusion lines above and below the calibration sphere 

 Create a single target variable containing only on-axis single targets representing the 
calibration sphere 

 Display the measured TS mean of the on-axis single targets 

 Calculate the change required to the TS calibration constant 

 Apply the change to the TS calibration constant 

 

Data folder:  
C:\Myriax\Echoview\Echoview4\Echoview manual\10 Appendices\Appendix H data 

 

Open the prepared EV file 

• Open the file Virtual Variables (Calibration).EV 
This EV file contains calibration data recorded from a Simrad ES60 

• Check calibration of the raw variables! 
All calibration values that are known at this time should be entered (check the 
Details dialog box). 
 
For this exercise you will need to initially calibrate all variables using the setting 
From first ping (see note below), fill out the Calibration 2 pages and calibrate the 
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Transducer. Later on you will need to use the Manually setting to apply your 
calculated Transducer gain which is needed to calibrate the TS mean to -
35.00dB. 
 
Note:    To read calibration values from any Ex60 data files (.raw, .ek6 or .ek60), 
select the option From first ping of the setting Apply calibration settings on the 
Calibration page of the Variable Properties dialog box and then select Apply to 
apply those settings to the echogram. For new EV files this is set by default. That 
is, the calibration settings will be read directly from the first ping stored in the 
first data file which contributes to a variable and is used to populate the 
Calibration page of the Variable Properties dialog box. The Calibration 2 page of 
the Variable Properties dialog box needs be used also. 
 
For each variable, you will need to select a setting for Apply calibration settings 
on the Calibration page of the Variable Properties dialog box. When Manually is 
selected, every calibration value should be assessed and corrected (if required). 
 
Transducer calibration follows a separate path. Transducer calibration can be 

accessed on the Variables and Geometry window (F7) or via the  button on 
the Calibration page of the Variable properties dialog box. 

Create exclusion lines above and below the calibration sphere 

You must create these lines so the single target variable you create contains only single target 
detections representing the calibration sphere. 

• Display the TS Raw Pings T1 echogram and locate the samples representing the 
calibration sphere. 
Hint:  The echoes from the calibration sphere are at approximately 19m. 
Increase the color display minimum (press F12) to -60dB to see the clear trace it 
has left. 

• Create the upper exclusion line 
Click the Line draw tool then click New Editable Line 
Select Fixed depth  
Fixed depth = 17.75 
Create a new line = Above cal sphere 
Click OK 

• Create the lower exclusion line 
Click the Line draw tool then click New Editable Line 
Select Fixed depth  
Fixed depth = 21 
Create a new line = Below cal sphere 
Click OK 

• Close TS Raw Pings T1 echogram 
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Create a single target variable containing only on-axis single targets 
representing the calibration sphere 

• Open the Variables and Geometry window (F7) 
Click the Variables and Geometry tool on the tool bar, or the click Variables 
and Geometry on the View menu 

• Open the New Variable dialog box 
Object > New > Variable 
or, Shortcut menu: New > Variable 

• Create the variable 
Name = On axis single targets 
Operator Group = Single target detection operators 
Operator = Single target detection - split beam (method 2) 
Click OK 
Operand 1: Fileset1: TS raw pings T1 
Operand 2: Fileset1: Angular position raw pings T1 
Click the Single target detection tab 
Minimum normalized pulse length: 0.6 
Maximum normalized pulse length: 1.2 
Exclude targets above line: Above cal sphere 
Exclude targets below line: Below cal sphere 

• Display an echogram of the On axis single targets variable 
The variable currently displays single targets representing the calibration sphere. 
At this stage it contains all single targets which met the detection criteria 
(represent the calibration sphere) regardless of whether or not they lie on the 
beam axis. 

• Note down the number of single targets 
Click the Horizontal band tool (4). 
Make a selection that covers all single targets 
On the Shortcut (right-click) menu, click Define Region 
Name: Cal sphere single targets 
Type: Analysis 
Click the close button 
On the Shortcut menu, click Analyze Region 
Note down the number of single targets 
 

No. of Single Targets  

Click OK 
 

• Filter out off-axis single targets 
Note: For this purpose you can filter targets using beam compensation or angular 
position in the beam. In this exercise you will use the beam compensation. 
Open the Variable Properties dialog box (F8) 
Click the Single Target Detection tab 
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Maximum beam compensation: 0.5 
Click OK 
Note: The off-axis targets are removed from the echogram in real time when live 
viewing data with Echoview. This makes it possible to continue a calibration 
sounding for as long as necessary to generate enough data for calibration by 
monitoring the quality of the data as it arrives.  

• Note down the number of on-axis single targets 
Click the Cal sphere single targets region 
On the Shortcut menu, click Analyze Region 
Note down the number of single targets 
 

No. of Single Targets  

 

How many off-axis single targets has Echoview filtered out? What is the likely 
impact of this on the calibration results? 

Display the measured TS mean of the on-axis single targets 

• Click the Cal sphere single targets region (if not already selected) 
On the Shortcut menu, click Analyze Region 

• Note down the TS mean 
 

TS mean  

 

Calculate the change required to the TS calibration constant 

In this step you will calculate the change that is required to the current TS calibration 
constant to make the measured TS mean of the calibration sphere equal to the theoretical TS 
value of the calibration sphere. This data was generated using a -35.00 dB calibration sphere 
so we should measure a mean TS of -35.00 dB in Echoview. We adjust the calibration 
constant to achieve that result. 

 

Use the following equation: 
 

2
tm TSTS

C
−

=∆  

 

where: 

C  = TS calibration constant 

TSm  = measured TS mean 

TSt  = theoretical TS value of calibration sphere (-35.00dB for this 
exercise). 
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Change to TS calibration constant  

 

Note: This equation is valid for raw data logged by the Simrad Ex60 series of 
echosounders – it may not apply to your echosounder. You will need to know how 
Echoview calculates TS values from the data stored in the data files you have logged. 
This is documented in the Echoview help file (Reference>Algorithms>Echosounder 
Algorithms>...) or you can contact Echoview support for details. 

Apply the change to the TS calibration constant 

• Display the Fileset1 : TS raw pings T1 echogram 

• Display the Variable properties dialog box 
Click the Variable properties tool 

• Change the TS calibration constant 
Click the Calibration tab 
Select the Apply calibration settings option Manually 
Transducer gain: Add the change you calculated in the previous step to the value 
in the text field 
Click OK 
Note:  The name of the TS calibration constant setting may be different for 
variables derived from different echosounders. This exercise assumes all other 
settings on this dialog box are accurate and represent the conditions during 
sounding. In practice, before determining the calibration constant you must 
determine the absorption coefficient, sound speed, transmitted power and pulse 
length and enter them here. 

• Display the Fileset1: Sv raw pings T1 echogram and apply the change to the TS 
calibration constant. 
Note: Sv data needs a further calibration to account for uncertainties in the beam 
volume. In this example this is the Sa correction term you see on the Calibration 
page of the Variable Properties dialog box.  

Check your results 

• Display an echogram of On axis single targets variable 

• Analyze the Cal sphere single targets region 
On the Shortcut menu, click Analyze Region 
Note down the TS mean 
 

TS mean  
 

The TS mean should be equal to the theoretical TS value of the calibration sphere, 
i.e. -35.00 dB. If it isn't, try to work out why by reviewing the exercise steps 
and/or comparing your EV file to Virtual Variables (Calibration) Solution.EV. 

• Apply the TS calibration constant to all variables for which it is used 
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Calibrate the Sv variable 

This exercise has thus far calibrated TS data – that is determined the appropriate echosounder 
constant (TS gain value) to convert the logged raw power data to the correct TS values. We 
leave it to you to apply a comparable technique to the Sv data. You will need to combine 
elements of the technique above and techniques you used in a previous exercise (Exercise 9: 
Removing Pings With No Single Targets from Sv Variable). 

Exercise 9 is a part of the Echoview training materials for the Virtual Variables exercise set. 
Please contact the Echoview support team (support@echoview.com) if you need advice in 
pursing the Sv calculations. 

In summary your goal is: 

 Create a single targets variable containing only on-axis soundings form the cal 
sphere 

 Create an Sv echogram containing only pings from the on-axis single targets 

 Display the measured Sv mean of the calibration sphere echo trace 

 Calculate the change required to the Sv calibration constant (Sa correction) 

 Apply the change to the Sv calibration constant 
 

Hint: the theoretical Sv for a calibration sphere of -35.00 dB target strength can be calculated 
as follows: 

 
�TLogRTSS tvt −−−= )(10)log(20  

 

Where: 

  TSt = Theoretical TS of the calibration sphere (-35.00 dB in this exercise) 

  R = Range of the calibration sphere (19m in this exercise) 

T = Mean thickness (height) of the region you are integrating. This region 
must contain all the energy of the cal sphere and ideally only the 
energy of the cal sphere for an accurate calibration. 

� = Two-way beam angle (dB) – a property of the transducer. 

Finish exercise 

• Close Echoview - save a working copy of the EV file 

 



Appendix I          136 

 136 

Appendix I: Introduction to DIDSON data 
processing. Topic 8 Calculations and 
graphs 

Example calculations and graphs 
Exported fish track analysis data can be processed in a number of ways to reveal useful 
numerical information and trends about the observed fish.  

This tutorial shows you one variation of calculations and graphs that can be derived from the 
exported data in Topic 7. 

.csv file processing 

The exported fish track analysis file contains valid and invalid fish track regions. You will 
need to sort the file and delete regions where Num_targets equal -1 and 1. You will then sort 
by Region_ID to re-order the data correctly for use in the calculations workbook. 

30. With Windows Explorer open your export file gt 20cm target length by cells.csv   
 
C:\Myriax\Echoview\Echoview4\Echoview manual\10 Appendices\Appendix I 
data\gt 20cm target length by cells (Solution).csv 
- OR -  
Click the file. 
On the Shortcut menu click Open. 

31. Select the whole sheet. 

32. On the Excel Data menu click Sort. 

33. Under the Sort by section: 
Select Num_targets, Ascending 
Click OK. 

34. Delete all rows where Num_targets equal 1 or -1. 

35. Select the whole sheet. 

36. On the Data menu click Sort. 

37. Under the Sort by section: 
Select Region_ID, Ascending 
Click OK. 

38. Save the sorted file as gt 20cm target length by cells.xls 

Excel workbook – Calculations and graphs 

The prepared fish track data is copied to an Excel workbook that has been configured to run 
pivot table calculations, formulas and plot graphs. 
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The workbook has been set up to use prepared fish track analysis data. The prepared data 
must be copied to the Fish tracks worksheet.  

Use the data from gt 20cm target length by cells (Solution).xls 

39. Open  
C:\Myriax\Echoview\Echoview4\Echoview manual\10 Appendices\Appendix I 
data\DIDSON Tutorial Statistics and Fish Flux (Solution).xls 

40. The worksheets of the workbook solution file have been protected (in a simple way). 
To remove the protection for each sheet do the following: 
On the Tools menu select Protection >Unprotect. 

41. Examine the calculations and graphs in the workbook.  

Tips and tricks 

You can use the workbook as a template for fish track analysis data exports that contain different analysis 
variables than those specified by the Echoview DIDSON tutorial set. However you may have to reconfigure the 
source data for tables and graphs. The histogram graph will also need to be redrawn using the Excel Add-in 
Data analysis > Histogram. 

Refer to the Echoview help file for more information regarding: “About fish track regions (Invalid fish tracks”). 

Configuration  

 

Figure 87. The Configuration worksheet. 

This worksheet defines Named worksheet variables that are used throughout the workbook.  

Intermediate calculations  

 

Figure 88. The Intermediate calculations worksheet.. 

This worksheet displays intermediate calculations for fish count and fish flux. Formulae use 
Excel Lookup functions and Named variables. 
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Basic statistics and fish flux  

 

Figure 89. Basic statistics and fish flux worksheet. 

This worksheet displays upstream and downstream calculations for: 

• Fish number via a pivot table. 
• Fish number/hour via a formula that sources data from the pivot 

table and the workbook.  

Fish tracks  

 

Figure 90. Fish tracks worksheet. 

This worksheet contains the processed fish track analysis export data. 

Topic completed 

You have completed this topic and should now be aware of some of the types of information 
you can derive from Echoview fish track analysis export data. 


